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Introducing Jaws PDF Server

Jaws® PDF Server™ (JPS) is a centralized server solution that converts PostScript®
language, EPS files and TIFF images into optimized PDF files. PDF (Portable Docu-
ment Format) is the industry-standard solution for publishing documents so they can
be read on any platform equipped with an appropriate reader. Jaws PDF Server is
powered by Global Graphics Software’s MaxWorkFlow™, the intuitive drag-and-drop
workflow management software.

1.1 The Jaws PDF Server GUI

The Jaws PDF Server GUI (graphical user interface) allows you to quickly and easily
setup and configure your PDF workflows. When a workflow is running you can see at
a glance its processing state, from the status bar above each module.

Refer to Chapter 3 for a detailed description of the Jaws PDF Server GUI.
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1 Introducing Jaws PDF Server

1.2 Jaws PDF Server modules

Jaws PDF Server consists of three modules, PDF Creator, SmartInput and Queuer.
These can be linked, in whatever configuration is required, to create your PDF work-
flows. A brief description of each module follows, but as you might expect, this
manual provides full and detailed descriptions for each module.

Smartinput

SmartInput acts as a ‘gateway’ to PDF Server. Jobs enter the workflow through the
SmartInput module and are passed to the other modules for processing.

Chapter 6 describes how to configure the SmartInput module.

Queuer
Queuer provides facilities for coordinating job flow through the workflow.

Chapter 7 describes how to configure the Queuer module.

PDF Creator

PDF Creator is the heart of Jaws PDF Server. It converts jobs into PDF files that are
compliant with Adobe® PDF 1.3 and 1.4 specifications.

Chapter 8 describes how to configure the PDF Creator module.

1.3 Running Jaws PDF Server as an NT service

Jaws PDF Server v3.0 can be run as a server service on Microsoft® Windows NT® 4.0,
Windows® 2000 or Windows® XP. The service may be added during program installa-
tion and the usual service options for starting, stopping and selecting security proto-
cols are available to the administrator.

1.4 About this manual

This manual is a complete guide to using Jaws PDF Server. It is intended for anyone
using or evaluating Jaws PDF Server on a PC running Microsoft Windows NT 4.0,
Windows 2000 or Windows XP
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1.5 Registering Jaws PDF Server

1.5 Registering Jaws PDF Server

A registration card is included with Jaws PDF Server. Please take a moment to com-
plete the card and post it to Global Graphics Software. You may also register online at
http://www.jawspdf.com. By registering Global Graphics can provide you with the
latest product news and free software updates. However, if you prefer, you may
choose not to receive correspondence from us when registering.

1.6 Jaws PDF Server Technical Support

If you need help or have a question on Jaws PDF Server you can access the Jaws sup-
port pages at http://www.jawspdf.com and view a list of Frequently Asked Questions.
If your query remains unanswered you can contact Jaws PDF Server technical support
at the address given on the support site.

Jaws PDF Server 3.0 8
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2

Installing Jaws PDF Server

This chapter describes the procedure for installing Jaws PDF Server. Before you begin
installing make your system meets the recommended system specs, as listed in the
table on page 11, to ensure correct working of Jaws PDF Server. If your system does
not meet these specifications you should consider upgrading.
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2.1 Recommended system specifications

Components

Requirements

Processor

Operating System

Minimum Disk space
System memory
Network adapter
Applications

Server services

Clients supported

Pentium 11l (600MHz or better)

Windows NT 4.0 Server or Workstation®
Windows 2000 Server or Professional®
Windows XP Professional®

500 MB

128 MB (256 MB or more recommended)
Ethernet 10 MB (Ethernet 100 MB recommended)
Internet Explorer 5.0 or greater installed

Macintosh services
TCP/IP printing

Windows 98/NT4.0/2000/XP
Mac OS 8.5/9.x° and OS X

Linux®

a. Server required for Macintosh connectivity and FTP server.

b. Windows XP does not support Macintosh connectivity.

c. AppleTalk not supported on Windows XP.

d. Requires Samba client (or similar) to be installed. Does not support Jaws virtual printers.

2.2 Installation procedure

1. Jaws PDF Server can be installed on Window NT, Windows 2000 and
Windows XP. Log on to your system as Administrator to ensure you have
sufficient privileges to install the application files.
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2.2 Installation procedure

2. Insert the Jaws PDF Server CD-ROM and open it in Windows Explorer or
My Computer. Start the installer by double-clicking Setup.exe to launch the
InstallShield® Wizard, as shown in the diagram below.

JAWS PDF Server v 3.0 Setup

Welcome to the InstallShield Wizard for
JAWSPDFServer

The InstallShigld® wWizard will install J&w'SPOFServer on
your computer. To continue, click Mext.

Cancel |

Figure 2.1 Jaws PDF Server installer wizard

The installer takes you through the process of installing Jaws PDF Server and its
associated features. Click Next to proceed in the installer or click Back to go
back a step.
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2 Installing Jaws PDF Server

3. The installer allows you to choose the features you want to install from the CD,
as described in the following table:

Jaws PDF Server Installs the Jaws PDF Server

Program Files application.

Sample files Installs sample files and calibration
targets.

MS Office Macros Installs Microsoft Office macros so

PDFs can be created directly from
Word or PowerPoint.

Jaws PDF Server as Installs the Windows Service for Jaws
Windows Service PDF Server, allowing the application
to be run as a Windows Service.

Jaws PDF Server Installs Jaws PDF Server manuals.
Documentation

Table 2.1 Installation features in Jaws PDF Server

4. During installation you will be prompted for the Jaws PDF Server license file,
which is supplied on the floppy disk provided. The license can only be used
with the supplied dongle, and consequently Jaws PDF Server will not run if an
incorrect license file/dongle combination is used.

5. After the installer has done copying the files click Finish to close the installer
window. The Jaws PDF Server Windows Service is only activated after you
restart your computer.

6. To start Jaws PDF Server, you may double-click the Jaws PDF Server icon on

e your desktop (only if you added this during installation), or you can access the
JA@EDF Jaws PDF Server program group in the Start menu and launch the application

Server from there. Remember to restart your computer after setting up the PDF server

if you are using the Jaws PDF Server Windows Service.

2.2.1 Loading Jaws PDF Server with startup parameters

You may also load Jaws PDF Server from a command line using the following startup
parameters:
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2.2 Installation procedure

C:\<installdir>\Man.exe [-c:filename.cfg] [-start] [-min]
where:

[-c:filename.cfg] loads the specified workflow

[-start] starts the workflow

[-min] starts minimized
A typical command might be:

C:\<installdir>\Man.exe -c:C:\JPSData\Config\WorkFlow.cfg
-start -min

2.2.2 Running Jaws PDF Server as a Windows Service

If you added Jaws PDF Server as Windows Service during the installation procedure,
the Jaws PDF Server may be run as a Windows Service, allowing the PDF workflow
to run without an application window (GUI). Once installed, JPS Service is added to
your list of Windows Services and can be started and stopped from the services
control panel.
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3

Jaws PDF Server Interface

The Jaws PDF Server interface (GUI) provides an intuitive working environment that
allows you to quickly and easily create PDF workflows. Using module building
blocks and links, you can create complex processing workflows very easily. The main
feature of the GUI are highlighted in Figure 3.1, and described in the following sec-
tions.
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3 Jaws PDF Server Interface

Control
toolbar

Workflow
modules

". JAWS PDF Server [C:\JPS_Data\ConfighPrograminterface.cfg]

Ele View Configuigtion Modules Help

/ol X B
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=
\

\ - —
Status bar g - ‘ ~ :@

SmartScan PressReady GLeUer Jaws POF Creator PressResdy
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palette

\
Module log
indicator

— —
a
SmartScan WehReady a— JEWS PDF Creator WebReacy

Queuer 2

oLl

SmartScan PrintReacdy
JANS PDF Creator PrintReacy

\
Remote
server
indicator

JAWS POF Crestor PressReady: End processing job Microsoft word - Morthly Sales Chart.doc st 14:06:29
L8305 POF Creator PressReady: Start processing job Microsoft Word - Manithly Sales Chart doc at 14:07:45

JAMS PDF Creator PressReady: End processing job Microsoft Word - Monthly Sales Chart doc st 14:07:55

[
Message Iog SmartScan PrintReady; Paused at 140102 14:08:04

window

17

JAWS POF Creator PrintReady: Paused 14:03:10

SENE

| ‘SmartScan PrintReady on PHOSPHORUS | " Idle Server paused‘
Server location Status of Server status
of selected module selected module

Figure 3.1 Jaws PDF Server window features
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3.1 Control toolbar

3.1 Control toolbar

The Control toolbar, shown in Figure 3.2, contains tools for selecting, linking, config-
uring and deleting modules. To select a tool click it once in the toolbar. When a tool is
selected it appears “pressed-in” to indicate that it is active, as shown in Figure 3.2.

Active tool

Figure 3.2 Control toolbar

The following tools are available in the Control toolbar:

% Selector
=

Use this tool to select a module or a link on the Design palette. A broken line
around a module indicates that it is selected. Once a component has been
selected you can move it around the Design palette, or use the other tools in the
toolbar to configure or delete it.

Log on/off

Use this tool to enable/disable module message logging. Any messages gener-
ated by the module, that is, when the module is started, stopped or processes a
job, results in a message being written to the file ¢: \JPS_Data\Log\MFW. LOG.

A small = icon appears beneath the module when message logging is enabled
for that module.

7 Link

Use this tool to link modules on the Design palette when creating workflows.
Jobs flow from module to module in the workflow along the links created by
the Link tool. The Link tool has some intelligence, it will not let you link mod-
ules that result in an illegal workflow being created.
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3 Jaws PDF Server Interface

Select computer

(@]
E

Use this tool to choose a remote Jaws PDF Server to run the selected module
on. From the Select computer dialog box, Figure 3.3, choose the remote
Jaws PDF Server machine and click OK. Jobs entering the module are trans-
ferred to the remote server and returned when the job has been processed.

The requirements for remote Jaws PDF Server processing are discussed in
Section 3.9, “Networking Jaws PDF Servers”, starting on page 37.

Select computer %

&l WEGA =]
WWWICE

WWINCENT

WIRLSTS

WIRLS2

WwARLOCK

WWELCOME

..... | L nnF

—
----- = WWIZARD _I

Computer name: |\ WwWHIRLYGIG

()8 I Cancel |

Figure 3.3 Select computer window

ﬂ Delete

Use this tool to remove selected items from the Design palette. For security rea-
sons, when a module is removed its associated folders remain intact and are not
deleted. To remove these folders from your computer you must delete them
manually. The folder’s location can be determined from the General tab of the
module setup dialog box.

Object setup

Use this tool to open the setup dialog box containing all the options for the
selected module. In Jaws PDF Server each module has a set of options that
allow you to specify exactly how jobs should be processed. Refer to the rele-
vant module chapter for a description of each option in the setup dialog box.
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3.2  Module toolbar

Start / Stop

Use this tool to start and stop modules. In a workflow a module must be started
] before it is allowed to process jobs. The button icon shows the action to per-
form when the button is clicked, that is, when the button shows ® clicking it
starts the module.

Auto Arrange

Use this tool to automatically tidy up and arrange the modules that are on the
Design palette. It is particularly helpful when you have several workflows and
you want to create space for more. The tool has several auto arrange options:

Horizontal tree
“{ Automatically arranges modules currently on the Design pal-
ette in a left-to-right configuration.

a | Vertical tree
i’;{. Automatically arranges modules currently on the Design pal-
ette in a top-to-bottom configuration.

Line Tree

A Automatically organizes complex workflows currently on the
Design palette, such as those containing multiple occurrences
of scan and destination modules.

Horizontal line
-l§ Selected modules are aligned horizontally at the point where
the tool is clicked on the Design palette.

Vertical line
RE Selected modules are aligned vertically at the point where the
tool is clicked on the Design palette.

3.2 Module toolbar

The Module toolbar, shown in Figure 3.4, contains the processing modules that you
will use to build your PDF workflows. To use a module first select it then click on the
Design palette where you want the module placed. The toolbar also shows modules
from remotely connected Jaws PDF Server servers, and you can use its modules in
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21

your workflows to process jobs. Section 3.9, “Networking Jaws PDF Servers”
describes how to add a remote Jaws PDF Server server and use its services to process
jobs.

Jaws PDF |

X E™

Figure 3.4 Module toolbar

The Module toolbar contains the following:

4 The SmartInput module accepts jobs into the workflow. It is always the first
module in a workflow. You can set up shared network folders and virtual Jaws
PDF printers in the SmartInput module. The features of this module are
described in Chapter 6.

i The Queuer module is used in workflows as a flow-control mechanism. Jobs

[M¥ are held by the Queuer until the destination module is available to process the
next job, and the job is released. In the Queuer view window (see Section 7.4
on page 88) jobs can be held, redirected and reprocessed. The module is
described in detail in Chapter 7.

mﬂ The PDF Creator module converts jobs submitted to the workflow into fully

< optimized PDF documents, suitable for viewing on any platform with the
appropriate PDF reader software. The many features and options that can be set
in the module are described in Chapter 8.

3.3 Design palette

The Design palette forms the main part of the application window and is the place
where you create your processing workflows. Jaws PDF Server uses a mouse driven,
drag-and-drop GUI (Graphical User Interface) that allows you to easily create, config-
ure and customize a workflow. Modules are connected to one another using an intelli-
gent Link tool that prevents you from creating incorrect workflows. Section 4.1,
“Setting up a PDF workflow” describes how to create workflows and save them to
disk. Chapter 5, “Example Workflows” gives examples of some commonly imple-
mented workflows.
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3.4 View log window

3.4 View log window

The View log window, shown in Figure 3.5, is used by Jaws PDF Server to display
module and system messages. This information is useful in determining what the
server is doing and is a useful tool when diagnosing problems and issues.

You can show/hide the View log window by choosing View log from the View menu.

Input Folder 2: Started at 2109001 11:44:49

Generate PrePress PDF. Pauzed at 21/09/01 11:45:00
Generate Web PDF. Paused at 210901 11:45:00
Generate Document PDF: Paused at 21/09/01 11:45:00
Gueuer: Paused at 210901 11:45:00

|nput Folder 1: Started at 2109101 11:44:49

Generate ek POF on PHOSPHORUS | Idle |Server paused

Figure 3.5 View log window

3.5 Menus

The menus contain commands and options used in Jaws PDF Server. You can access a
menu using the mouse or by ALT+<shortcut key> (letter underlined in menu name).

The menus contain the following items:

3.5.1 File menu

New Choose this item to clear the Design palette.
Jaws PDF Server prompts you to save any changes before
clearing the Design palette.

You can also access this option by pressing Ctrl+N on your
keyboard.
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3 Jaws PDF Server Interface

Open Choose this item to clear the Design palette and load a saved
configuration. From the Open dialog box, Figure 3.6, choose
the configuration to load and click the Open button.

Jaws PDF Server prompts you to save any changes before
clearing the palette and opening the new configuration.

You can also access this option by pressing Ctrl+O on your
keyboard.

Open [ 7] x|
Look in: Iaw’mkflows LI gl
[#] Multiple Server.cig
[#] Press PDFs.cig

] Print PDFs cig
] el PDFs cig

File name: IMuItipIe Server.cig Open I
Files of type: [l Files (~cfa] =l Cancel |

Figure 3.6 Open dialog box
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Save

Save as

Import

Jaws PDF Server 3.0

3.5

Choose this item to save the contents of the Design palette to
disk. The first time you save a configuration,

Jaws PDF Server prompts you for a name. In the Save As
dialog box, Figure 3.7, enter a name for the file and choose a
location, if necessary.

You can also access this option by pressing Ctrl+S on your
keyboard.

Save As H
Save jn: | _A Corfig j ﬂ
] PDFPressReadyServer.cig
] PDFwebServers.cfg

] RemateServers.cfg
8] SecuityPDFServer.cfg
8] Simple.cfg

File name: |NewPDFServer Save |
Save as ype: |AII Filez [*.cfg) ﬂ Cancel

Figure 3.7 Save As dialog box

Choose this item to save a copy of the configuration using
another file name. You may want to do this if you have made
changes to an existing configuration and wanted to save the
changes as a new configuration.

You can also access this option by pressing Ctrl+E on your
keyboard.

Choose this item to import a MaxWorkFlow export file
(.me£), allowing you to recreate a workflow that has been
setup and configured on another Jaws PDF Server
installation.

In the dialog box that opens, navigate to the file and click
Open. The Design palette is cleared and the new configura-
tion is loaded, along with its module settings. See also
Export.

24
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3 Jaws PDF Server Interface

Export Select this option to export workflows, modules and module
settings to a MaxWorkFlow export file. This allows you to
share workflow configurations between Jaws PDF Server
installations.

In the dialog box that opens, choose a name and location for
the file and click Save. Use Import to open an exported file.

Options Choose this item to open the Options dialog box, Figure 3.8,
where the overall system settings for Jaws PDF Server are
configured, as shown in Figure 3.8. The controls in Options
are described in Section 3.6, starting on page 29.

You can also access this option by pressing F3 on your key-
board.

Options
System l Desktap ] Metwark ]

V¥ Auto load last configuration

[ Stop system if ilegal link added

Log file directory:
CAJPS_Datatlog H

t awirnumn log file size: {10240 Kb

Default measure unit: |inches < Apply

oK | N

Figure 3.8 Options dialog box

Exit Choose this command to close the Jaws PDF Server applica-
tion, stopping all job processing in the process. Before shut-
ting down, the system prompts you to save any changes made
to the present configuration.

You can also access this command by pressing Alt-F4 on your
keyboard.
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3.5.2 View menu

View Log

Modules Toolbar

Control Toolbar

Switch Icon Size

Auto Arrange

Jaws PDF Server 3.0

3.5

Choose this option to show/hide the View log area of the
application window. See Section 3.4 for more information on
the information presented in the View log area.

You can also access this command by pressing Ctrl+G on
your keyboard.

Choose this option to show/hide the Module toolbar in the
application window. Section 3.2, starting on page 20, details
each of the modules available in the toolbar.

You can also access this option by pressing Ctrl+M on your
keyboard.

Choose this option to show/hide the Control toolbar in the
application window. Section 3.1 on page 18, details each of
the tools available in the toolbar.

You can also access this option by pressing Ctrl+T on your
keyboard.

Choose this option to alter the icon size of the modules on the
Design palette. There are three sizes available to help you
organize your workflows. The menu options rotates through
each of the available icon sizes.

You can also access this option by pressing F7 on your
keyboard.

Choose this option, and the appropriate sub-option, to let
Jaws PDF Server automatically arrange the modules on the
Design palette.

You can also access these commands by pressing F8, F9 and
F10 on your keyboard, or by using the Auto Arrange tool in
the Control toolbar, see page 20.
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3.5.3 Modules menu

Workflow Start

Start / Stop

Delete (Del)

Setup

Choose this option to start and stop all of the modules on the
Design palette, enabling your workflows to process incoming
jobs.

You can also access this command by pressing F2 on your
keyboard.

Choose this option to start/stop the selected module(s) on the
Design palette. A module must be running (started) before it
can process jobs. Jobs that are sent to a stopped module are
queued until the module is restarted.

You can also access this command by pressing Ctrl+P on
your keyboard, or by using the Start/Stop tool in the
Control toolbar, see page 20.

Choose this option to remove selected modules from the
Design palette. For security reasons, when a module is
removed its associated folders are not deleted. If you want to
delete them from disk you must delete them manually from
the system.

You can also access this command by pressing Del on your
keyboard, or by using the Delete tool in the Control toolbar,
see page 19.

Choose this option to open the module’s configuration dialog
box. Each module has many options that allow you to control
job processing. Refer to the module chapter for a description
of each option available.

You can also access this command by pressing F5 on your
keyboard, by right-clicking the module and choosing Setup
from the pop-up menu, or by using the Object setup tool in
the Control toolbar, see page 19.
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View

3.5

Choose this option to open the job view window for the
selected module. This window presents details about the
module’s status, job details and message logs. Refer to the
module chapters in this manual for a description of the fea-
tures in each view window.

You can also access this command by pressing F4 on your
keyboard, or by right-clicking the module and choosing View
from the pop-up menu.

Change Computer

Log On/Off

Select All

Jaws PDF Server 3.0

Choose this option to select a remote machine on which to
process the jobs received by the selected module. Networking
Jaws PDF Server installations is discussed in Section 3.9 on
page 37.

You can also access this command by pressing F6 on your
keyboard, or by using the Select computer tool in the
Control toolbar, see page 19.

Choose this option to enable/disable message logging for the
selected module(s). Messages are generated whenever the
module is started or stopped, when a job is processed or when
an error occurs. These messages can be viewed in the mod-
ules job view window, or they can be output to the

Jaws PDF Server log file ¢:\JgPs_Data\Log\MFW.LOG and
viewed in a text editor. To indicate that messaging is enabled,
asmall = icon appears beneath the module on the Design
palette.

You can also access this command by pressing Ctrl+L on your
keyboard, or by using the Log on/off tool in the
Control toolbar, see page 18.

Choose this option to select all items on the Design palette.

You can also access this command by pressing Ctrl+A on
your keyboard,

28
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3 Jaws PDF Server Interface

3.5.4 Help menu

Quick Start Choose this option to view the quick start guide
Getting Started with Jaws PDF Server. This manual is also
included with the product in a printed version.

User Manual Choose this option to open the
Jaws PDF Server User Manual—the manual you are
currently reading.

About Choose this option to display information about the
Jaws PDF Server application. You may be asked to supply
this information should you need to contact Technical Sup-
port.

3.6 Options

System, desktop and network selections may be configured in the Options dialog box
by choosing Options from the File menu, or by pressing F3 on your keyboard. The
controls in the tabs are described in the following subsections.

3.6.1 Options: System tab

Options
System l Desktop ] Metwork ]

V¥ Auto load last configuration

[ Stop system if ilegal link added

Log file directory:
CAJPS_Datatlog H

t awirnumn log file size: {10240 Kb

Default measure unit: |inches < Apply

oK | N

Figure 3.9 System options
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3.6 Options

Auto load last configuration

When this check box is selected, the last saved configuration is automatically
loaded on the Design palette. This option is selected by default.

Stop system if illegal link added

When this check box is selected the system stops all job processing if a link is
added to the workflow that would cause an illegal link to be made. In practice
this feature has very little effect, since the Link tool is intelligent enough to
work out when an illegal link is being made and will not allow it to be made.
This option is not selected by default.

Log file directory

This option allows you to specify a directory location for the message log file
MFW. LOG. Enter the folder location directly into the text box or click the &
button then navigate to a folder.

Maximum log file size

This text box is used to specify a maximum file size for MFW.LOG. Messages are
appended to the log file until the maximum file size is reached, when the log file
is discarded and a new one created.

Default measure unit

Use the options available here to specify the units you want Jaws PDF Server to
use. Click OK to update the units.
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3.6.2 Options: Desktop tab

Options
System Desklop l Hetwaork ]

Calars lcon size

I Corect Link &+ Large
I Eror Link  Medium
Diesitep ¢ Smal
B Selected object
Grid options
Progress bar: Busy
|| [~ Snap to grid

M Frogress bar: Go

Horizontal: |32 pixels
Wertical: ’32— pixels

V¥ Show module name

[v¥ Show Status lcons in Modules

Figure 3.10 Desktop options

Colors

The options here allow you to determine the desktop colors used by

Jaws PDF Server. Click the item you wish to change and choose a new color
from the Colors dialog box that appears. The colors available are determined by
your overall system color palette, set up in

Control Panel > Display Properties.

Show module name

Select this check box to display module names on the Design palette so they can
easily be identified.

Show status icons in modules

Select this check box to show module status bars on the Design palette. The cur-
rent state of the module is indicated by the status bar color, as follows:

Black—the module is currently stopped. No processing allowed.
Clear—the module is currently started and is ready for a job.
Green—the module is currently receiving a job.

Blue—the module is currently processing a job.

Red—the module needs configuring to complete the workflow.
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3.6 Options

Icon size

Allows you to choose the icon size for modules on the Design palette. You may
also change icon size by choosing Switch icon size from the View menu, as
described on page 26.

Snap to grid

Choose this option to turn on an invisible grid that modules will be aligned with
when placed on the Design palette. Alter the grid spacing by entering values in
the Horizontal and Vertical pixels text boxes.

3.6.3 Options: Network tab

Options
il,lstem] Desktop  Metwork l

List of computers in use:

Bemove

()8 | Cancel |

Figure 3.11 Network options
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The Network tab contains the following options:
Add

Lets you add a remote Jaws PDF Server to your system. From the

Select computer dialog box (Figure 3.12) select the computer with

Jaws PDF Server installed then click OK. The PDF Server is added to the mod-
ules toolbar and its resources become available for use in your workflows.

Select computer %

----- &l \\WERMEER =]
WWYICE
WYINCENT
WWIRUSTS
WIRLS2
WWARLOCK
\WWELCOME
WHIRLYGIG
W HITE
WwHITESTAR
41 TCHBLADE
WwIZARD

—
----- ot WAWOOF
..... B 4IPS LI

Computer name: |\ WwWHIRLYGIG

()8 I Cancel |

Figure 3.12 Select the remote PDF Server

Remove

Lets you delete a server from the list. Select the computer you want to remove
and click the Remove button.

3.7 Module view window

Each module has its own module view window, where details relevant to the module
are displayed. The module view window is accessed by double-clicking the module,
right-clicking on it and choosing View from the pop-up menu, or by using the key-
board shortcut F4.
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3.7 Module view window

Figure 3.13 shows the view window for the SmartInput module. Many of its features
are common to all module view windows, and are described next. The relevant mod-
ule’s chapter describes module specific controls in detail.

Smartinput modules

,7M0dule Wiew Help

Menus a—
>+ d
—
Toolbar ame Statuz Log | Pause
Smartlnput PressHeady yes  yes
Smartlnput \WebR eady Idle yes  pes
Smartinput PrintFeady Idle yes  pes
—
Job/Module
list

Smartinput: Create NT printer Jaws PDF PressReady at 15801102 J
120321

-

Messages Smartinput 9: Creste MT printer Jawes POF - Printvel at 18/01./02

area 120327

Figure 3.13 Smartinput View window

Toolbar

The toolbar contains tools for the most commonly used commands in the View win-
dow. The toolbar is usually anchored above the View list but it may be pushed off and
become “free floating” on the Windows Desktop.

Tools that appear in each of the module’s View windows are described below.

Show / Hide
Use this tool to hide the View window when the toolbar is anchored, or to
show/hide the View list when the toolbar is detached on the Windows desktop.

(e !

Start / Stop

Use this tool to start and stop modules. In a workflow a module must be
started before it is allowed to process jobs. The button icon shows the action
to perform when the button is clicked, that is, when the button shows »
clicking it starts the module.

= v
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Abort job

Use this tool to abort the current job in progress. The tool only becomes active
when a large enough file is being processed, otherwise the button remains
inactive and appears disabled.

Delete

Use this tool to remove a selected module or job from the View list. When
deleting modules, the module is also remove from the Design palette; when
deleting jobs, the job is removed from the storage folder.

Job / Module list

The job / module list comprises the main part of the Viewer window and is used to
show all the modules that are of the same type currently on the Design palette, along
with their current processing and message log enabled status.

Messages area

The Messages area of the module’s view window displays processing messages for
the selected module in the View list. This information can be a useful tool when diag-
nosing job processing problems. Using the Log tool, described on page 18, you can
also output these messages to a log file so they can be viewed later in a text editor.

3.8 Module pop-up menus

You can access frequently used module commands from a pop-up menu by right-
clicking the module. Figure 3.14 shows an example pop-up menu. Many of the
options available are common to all modules and these are described next.

Setup F5
Fonts Chil+F2
Wiew F4
Llear Error

Launch module
Change Computer... FE
Delete [rel

About Module Chrl+F1

Figure 3.14 PDF Creator pop-up menu
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3.8 Module pop-up menus

Setup (F5) Opens the setup dialog box where options for the selected
module are configured. You can also access this command
using the Object Setup tool, described on page 19.

View (F4) Opens the module’s view window, described on page 33.

Clear Error Removes an offending error file from the SmartInput input
folder so that job processing can resume. The file is moved to
the error folder, located in the SmartInput input folder, for
example JPS_Data\Input\SmartInput\Error.

You may also configure the SmartInput module to automati-
cally deal with errors by selecting the appropriate method in
SmartInput options, as described in Section 6.3.1 on page 69.

Launch Module Initiates a module that has been shut down on the
Design palette. Modules that are shut down appear disabled
on the Design palette.

Change Computer
Allows you to change the computer that will process jobs
sent to the selected module. For more information on con-
necting to remote servers, see Section 3.9, “Networking
Jaws PDF Servers”.

Delete Removes modules and links from the Design palette. When a
module is removed from the palette, its associated folders
remain intact and are not deleted, you must delete folders
manually to remove them from your system. You may also
click the Delete tool (see page 19) to remove items from the
Design palette.
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3.9 Networking Jaws PDF Servers

A powerful feature of Jaws PDF Server is the ability to link with other

Jaws PDF Servers across a local area network (LAN) to share the job processing
workload. Jobs are submitted to the central server and distributed to remote servers for
further processing. The processed jobs are returned to the central server where
processing continues.

3.9.1 Requirements for processing jobs on a remote server

The following requirements are necessary to link Jaws PDF Servers across a network:

1.

Jaws PDF Server must be installed on machines which meet the minimum
specifications, as listed on page 11.

Jaws PDF Server must be installed on both machines but must not be loaded
and running on any of the remotely connected (slave) machines. Only the
master server should have Jaws PDF Server loaded and running.

The servers must be connected across a LAN.

COM security must be disabled on linked machines. You can disable COM
security during the initial Jaws PDF Server installation procedure. If you did not
turn off COM security during installation, re-install Jaws PDF Server and
choose this option when prompted. Reinstalling does not delete any of your
workflow configurations, so your settings will not be lost

There are two ways to configure modules in a workflow to run on a remote
Jaws PDF Server. Both methods are described next.
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3.9 Networking Jaws PDF Servers

Adding a remote server to the Module toolbar

You can add a remote Jaws PDF Server to the Module toolbar, as shown in
Figure 3.15, then use its modules in your workflows.

Local server Remote server

PHOSPHORUS ]EUGENgl

28 Y

Figure 3.15 Module toolbar with remote server

To add a remote server, right-click the Module toolbar and choose Add Computer
from the pop-up menu, or choose File > Manager Options and add the remote server
in the Network tab. Using either method, the Select computer dialog box opens, as
shown in Figure 3.16. Enter the network path to the remote Jaws PDF Server
machine, or navigate to it using the network tree. Click OK to add the remote com-
puter to the Module toolbar. The remote server’s module are displayed when you click
the tab and can be used in the workflow.

Select computer E

----- Bl \\HOBBIT =]
----- | WHUMPTY

SWHUNIR

WHUTEH

“WMPLODE

----- =1 WINFERND

----- \AJAFFREY

..... A7FER J
----- WKAISER

----- =] \KaWASAKI

WKISKA

WKODAKD

----- | WLANTRA

..... ] WhAAGIT LI

Computer name:  |\WJAZZER

Figure 3.16 Adding a remote Jaws PDF Server
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Configuring a module to run on a remote server

Any module already in place on the Design palette can be configured to run on a
remote Jaws PDF Server, through the Select computer dialog box, Figure 3.16. There
are several ways to open the Select computer dialog box:

* Right-click the module and choose Change Computer from the pop-up menu.
¢ Select the module and click the Launch computer tool in the Control toolbar.
* Select the module and press the shortcut key F9.

In the Select computer dialog box, enter the network path to the remote

Jaws PDF Server machine, or navigate to it using the network tree. Click OK to final-
ize the configuration. Now when a job is received by the module, it will be processed
on the remote server.
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3.10 Monitoring Jaws PDF Server

Jaws PDF Server provides several facilities to help you monitor the status of modules
and the progress of jobs through your workflows. Each tool, described in the follow-

ing sections, provides a useful way of checking the workflow is processing jobs cor-

rectly and that no errors have occurred.

Module status icons

Module status icons provide a quick way of viewing the current state of a module. The
status icons are located above each module on the Design palette, as shown in

Figure 3.17. The color of the icon indicates the present state of the module. If you
cannot see the status bar make sure you have them turned on in the Options dialog
box, see page 31 for details.

None: Module
v— is waiting for a
job

Black: Module is
stopped and
cannot process

jobs 8
J [print \ / [Prirt
Green: Module is .\\:5

processing a job

We /Gueuer
Red: Module needs [@ Blue: Module is

configuring to com- processing a

3
3

5] job
plete workflow @ J
Wik and Prirt =

Figure 3.17 Module status bars and their meanings
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Activity messages

Each time Jaws PDF Server processes a job or performs some action a message is
generated and output to the message log areas of the main Jaws PDF Server window
and the module’s view window, as shown in Figure 3.18.

Smartinput modules

Module  Yiew Help

>+ d

Mame Statuz Log | Pause
Smartlnput PressHeady

Smartlnput \WebR eady Idle yes  pes
Smartinput PrintFeady Idle yes  pes

Smartinput: Create NT printer Jaws PDF PressReady at 15801102 J

120321

Messages

area Smartinput 9 Creste NT printer Jawes POF - Printyveb at 1501102
120327

|

Figure 3.18 Smartinput viewer showing message area

These messages provide a useful monitoring tool since you are able to see all the pro-
cessing done by a module and view any errors which may have caused the module to
stop working.

Message log tool

The message log tool (shown left) provides a way to monitor individual modules and
save their messages in a log file so they can be viewed at a later date. To enable mes-
sage logging, select the message log tool and click on the module that you want to log.
Then, when the module processes a job or generates a message, the message is written
to MFW.LOG and may be viewed with a text editor. By default the log file is located in
C:\JPS_Data\Log but this may be changed in the Options dialog box, as described
on page 30.

Jaws PDF Server 3.0



3.11 Jaws PDF Server list of commands

3.11 Jaws PDF Server list of commands

Button

Command
Manager options dialog box

View/hide log window
Modules toolbar hide/show
Workflow toolbar hide/show
Change icon size

Create a configuration
Open a configuration

Save a configuration

Import a configuration
Export a configuration

Selector

Menu selection
File > Options

View > View Log

View > Modules Toolbar
View > Control Toolbar
View > Switch Icon Size
File > New

File > Open

File > Save

File > Import

File > Export

Shortcut
F3

Ctrl+G

Ctrl+M

Ctrl+T

F7

Ctrl+N

Ctrl+O

Ctrl+S

Start and stop the PDF server.

Modules > Workflow
Start/Stop

F2

Delete a module

Start/Stop a module

Modules > Delete

Modules > Start

Delete

Ctrl+P

Setup a module

Modules > Setup

F5

Module viewer

Modules > View

F4

Generate a log file.

Launch module from remote PC

Modules > Log on/off

Modules > Change Com-
puter

Ctrl+L

F6

Link tool

=@ Alignment tool

Jaws PDF Server 3.0

View > Auto arrange

F8, F9,
F10
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4

Using Jaws PDF Server

In Jaws PDF Server you create workflows using modules and links. When a job is sent
for processing it enters the workflow through the SmartInput module and is passed
from module to module—moving along the workflow until the job is processed into a
PDF. You must have at least one workflow running to process jobs; but to meet all the
processing requirements of your users, you are likely to need several workflows
running together.

4.1 Setting up a PDF workflow

Setting up a PDF workflow is simple and quick with Jaws PDF Server. You use an
intuitive, graphical, mouse-driven interface to place modules on the Design palette
and link them to create a processing workflow.

The procedures that follows take you through the process of creating a PDF workflow.

4.1.1 Placing modules

1. Begin with a clear Design palette by selecting New from the File menu.
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2. From the Module toolbar click the SmartInput module to select it. The module
icon appears “pressed-in” when selected, as shown in Figure 4.1.

Jaws PDF |

28

Figure 4.1 Module toolbar with Smartinput selected

3. With the SmartInput module selected, click on the Design palette where you
want the module located. The SmartInput module is placed on the Design pal-
ette at the point where you clicked. If this is not a suitable location, simple drag
the module to another place on the palette.

4. Next, place a PDF Creator module on the Design palette. Position it to the right
of the SmartInput module, as shown in Figure 4.2.

4 jia

Smartingput 1 JAWS POF Crestor 1
Figure 4.2 Smartinput and PDF Server modules

5. To create a simple workflow you should link the two modules with the
Link tool. Click the Link tool in the Control toolbar to select it.

b B XK S

=

Figure 4.3 Link tool
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4.1 Setting up a PDF workflow

6. With the Link tool activated, on the Design palette click the SmartInput module
and move the pointer to the PDF module. Notice a link arrow is drawn from the
SmartInput module and the pointer changes to a hand, as shown in Figure 4.4.

T T

Strartinpt 1 Jaws POF Creator 1

Figure 4.4 Creating a link

7. Click the hand on the PDF Creator module to create the link, as shown in
Figure 4.5.

Stmartinput 1 JAWS POF Crestar 1

Figure 4.5 Smartinput and PDF Creator modules linked
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Configuring the modules

1. Use the setup dialog box to configure the workflow modules so that jobs are
processed according to your requirements.

There are several ways to open the setup dialog box:
* Right-click the module and choose Setup from the pop-up menu.

* Select the module and click the Setup tool in the Control toolbar,
Figure 4.6.

£ JAWS PDF Server

File “iews Modules Help

[%’ } )( SPARKEY |
-2 BT
Object setup [F5]

Figure 4.6 Click the Setup tool

¢ Select the module and choose Setup from the Module menu.

* Select the module and press F5 on the keyboard.
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4.1 Setting up a PDF workflow

2. Using whichever method you choose, open the module’s setup dialog box.
Figure 4.7 shows the setup dialog box for the SmartInput module. Notice how
the dialog box is organized into tabbed areas, making it is easy to locate a partic-

ular option.

Smartinput Setup

General l Additional ] Yirtual Printers ]

Module name: |Smart|nput PrezzReady

Scan directory:

|EI:\JF'S_D atatlnputtSmartinput_PrezsReady

&

Backup directorny: |

&

Destination modules:

File masgk: |"_" ﬂ v Jaw'S PDF Creator PressReady [ps.e
File type: ’m
Buffer size: 2048 KB

Error policy

" Pauze Smartinput module on error
" Delete emor file and continue work

&+ Move emor file to eror directary

Cancel

Figure 4.7 Smartinput Setup dialog box

3. For this example we will not be setting any module options. Refer to Chapter 5,
“Example Workflows” for a list of options used to produce several types of

commonly used PDF document types.

When you have finished looking at the various options available click OK to
close the setup dialog box. Any changes you have made to the module’s config-
uration options will be retained. If you do not want to retain any changes made
to the module options, click Cancel instead.

Jaws PDF Server 3.0
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Saving the Design palette configuration

After creating your workflows you may want to save the contents of the
Design palette to disk so that the configuration may be swapped out with another con-
figuration and recalled later. To save the workflow do the following:

1. From the Configuration menu choose Save. The Save as dialog box opens, as
shown in Figure 4.8.

Save jn: IJW’orkrows LI gl

[#] Multiple Server.cig
[#] Press PDFs.cig
] Print PDFs.cig

File name: IWeb FDFz Save I
Save as ype: IAII Filez [*.cfg) LI Cancel |

Figure 4.8 Save as dialog box

2. Inthe File name area enter a name for the workflow and click Save. Everything
on the Design palette is now saved, along with all the module settings. If this is
the last configuration to be saved before Jaws PDF Server is closed, the config-
uration will be automatically loaded when the Jaws PDF Server application is
reloaded.

3. To open a saved configuration choose Open from the Configuration menu and
select the saved file. The system prompts you to save any unsaved configura-
tions before the Design palette is cleared and the new configuration loaded.

Starting the workflow

Before jobs can be processed you must start the workflow. Once a workflow has been
started it is able to receive jobs and process them into PDF files.
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4.2 Submitting jobs for processing

There are several ways to start the workflow:
¢ Choose File > System Start.
*  Press F2 on your keyboard.
¢ Select the workflow’s modules and click Start/Stop in the Control toolbar.

*  Start the Jaws PDF Server service in the Services control panel in
Windows. This feature is new for Jaws PDF Server v3.0 and is described in
Section 1.3 on page 7.

4.2 Submitting jobs for processing

To submit jobs to the workflow for processing you must provide input mechanisms for
users. Jaws PDF Server allows you to submit jobs using a Jaws PDF Server virtual
printer or using a hot folder, as described next.

4.2.1 Using a Jaws PDF Server virtual printer

Setting up a virtual printer allows users to easily submit jobs directly from an applica-
tion program, such as Microsoft Word or QuarkXPress. The virtual printer handles the
process of passing the job to the workflow in the correct format for processing.

The virtual printer is created by the SmartInput module, as described in Section 6.3.3
on page 74, and published on the network just like any other networked printer.

Creating a Jaws virtual printer
The procedure for creating a Jaws virtual printer is as follows:

1. Select the SmartInput module that you want to add a virtual printer to and open
its configuration dialog box; by right-clicking the module and choosing Setup
from the pop-up menu, or by pressing F5 on your keyboard.

2. Select the Virtual Printers tab to reveal the virtual printer settings. The tab con-
tains all the settings for publishing the virtual printer on NT and
AppleTalk networks.

Note: Windows XP does not support AppleTalk so it is not possible to set up a
virtual printer for Apple Macintosh clients connecting to a Windows XP server.
Instead use hot folders as an alternative, see “Using a hot folder” on page 51.
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3. Mac users—To publish the printer on an AppleTalk network enter a name for

your Jaws virtual printer in the Printer name text box, and in the PPD text box
enter C:\<installdir>\PPD\PDFCreator.ppd, or click | and navigate to
the file in the Windows dialog box that opens.

NT and 2000 users—To publish the printer on an NT network enter the name
of the printer in the Printer name text box, and choose a name for the printer
share (this is the name of the printer that will appear on the network). You may
use the same name for both printer and printer share, but do not choose a name
that is already in use on your system.

From the list of printer drivers choose PDFCreator.ppd. If this driver is not
listed, install it by clicking the Create PS Printer Driver button.

Click Create printer to add the new printer to your list of installed printers and
publish it on your NT network. Click OK to close the SmartInput setup dialog
box.

Users may now add the new printer using the Microsoft Add Printer Wizard or
Chooser on a Macintosh computer. Windows users must be logged onto the
domain before they can add the printer successfully.

Once the virtual printer has been added it may be configured like other printer
drivers. For example, you can define the output page size used when printing
documents. In Windows this setting overrides the page size that has been
defined in the document application.

4.2.2 Using a hot folder

Another way for users to submit jobs for processing is through a hot folder. Jobs are
placed in the hot folder and picked up by the workflow and processed accordingly.
Jobs can only be processed when they are in a format recognized by the modules, that
is, they must be in PostScript language or TIFF image formats.

The hot folder is created in the SmartInput module, as described in Section 6.3.2 on
page 72, and published on the network as a shared folder. Users who have access to
the folder are then free to place jobs directly into the hot folder. You can specify who
can see the hot folder through the Windows file sharing permissions dialog box.
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4.2 Submitting jobs for processing

It should be noted that only PostScript language files generated by the Jaws

PDF Creator PostScript language printer driver (PDFCreator.ppd) can be correctly
and reliably processed by the Jaws PDF Server modules. PostScript language files
from other printer drivers may not be reliably processed, and may even cause the PDF
Server to stop processing.
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Example Workflows

This chapter describes how to set up and configure two example workflows. The first
example is created manually from a clear Design palette. It produces PDFs suitable for
web, print and press use. The second example uses a MaxWorkFlow export file to
automatically create a fully configured workflow which produces PDFs suitable for
web and print use. Both examples are typical workflows, commonly implemented in
Jaws PDF Server, which may be used as the basis for your own PDF server
workflows.
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5.1 Example web, print and press PDF workflow

The first example workflow produces three PDF file types. The features of the PDFs
are listed in Table 5.1, and Figure 5.5, page 63 shows the design for the workflow, as
well as the main features of the window. You may want to refer to this diagram when
setting up the example workflow.

Feature Web ready Print ready Press ready

PDF PDF PDF

Resolution 72 600 2540

Optimized for fast web Yes No No

viewing?

Thumbnails included? No No No

Color images 72 150 -

resolution

Grayscale images 72 150 -

resolution

Monochrome images 300 600 -

resolution

All fonts embedded? Yes Yes Yes

Security implemented None None None

Table 5.1 PDF features for the example workflow
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Control toolbar

& Jaws PDF Server

File | “iews Modules Help

Module toolbar

5.1 Example web, print and press PDF workflow

Design palette

i—i(i

[% } X 5% SF'J&FHKEY'
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g

|Smar1|nput PressReady

Smartlnput PrintReady

Smartinput YehReady

Gueuer

WebReady POF

PressReady PDF

Smartinput 11 Paused st 09008/02 131241 ;I
Queuer 4 Paused at 0900802 1312:41
‘WebhReady POF: Paused 131241 j
Queuer on SPARKEY | |dle |Server paused i
Figure 5.1 Example workflow
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5.1.1 Creating the example workflow

1. Load Jaws PDF Server and clear the Design palette—the main work area—by
choosing File > New from the menus.

2. Place three SmartInput modules, one Queuer and three PDF Creator modules on
the Design palette, arranging them as shown in Figure 5.2. To add a module,
select it from the module toolbar and click on the Design palette where you
want it placed.

— —
X i
Smartinput 1 FDF Crestor 1
— — —
X & i
Smartinput 2 Queler 1 PDF Creator 2
— —
X i
Smartinput 3 POF Creator 3

Figure 5.2 Workflow modules arranged on the Design palette

3. From the Control toolbar choose the Link tool—shown right—and link the
modules to create a workflow. Start by linking the SmartInput modules to the
Queuer module and continue until the modules are linked to form the workflow
shown in Figure 5.3.

— —
Smartinjut 1 PDF Crestor 1
—

=

Smanlnpm/gueuer 1 POF Creatar 2

&

Smartinput 3 PDF Creator 3

Figure 5.3 Modules linked
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5.1 Example web, print and press PDF workflow

5.1.2 Configuring the modules

It is usually necessary to configure the modules in a workflow to obtain the required
PDF features, such as resolution and security settings. In Jaws PDF Server each
module contains a set of options which may be accessed by selecting the module and

clicking Object setup, shown right. -
. . . ~ Object setup
In the example workflow, configure the PDF Creator modules using the informationin  tool

Table 1 on page 59, then install the Jaws printer driver, as described in Installing the
Jaws printer driver on page 60, before configuring the SmartInput modules with the
information in Table 2 on page 61. It is not necessary to change the settings in the
Queuer module as the defaults are suitable.
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Options PDF Creator Modules
Web Ready Print Ready Press Ready
Module Name WebReady | PrintReady PressReady
PDF PDF PDF
Thumbnail generation None None None
Resolution 72 dpi 600 dpi 2540 dpi
Optimize for fast web viewing V1] [ ] [ ]
Auto-rotate Pages 1 1 1]
Share output folder as [v]PDF [v']PDF [v']PDF
Append user directory to path 1 1] 1]
Use Title as Output file name 1 1] 1
§ Convert CMYK -> RGB v] [ ] [ ]
% Preserve Overprint [ ] [ ] v]
G  Preserve OPlI Comments [ ] [ ] V]
.2 Embed all fonts 1] V1 1
£ Subset all fonts V] V] [ ]
Downsample Bicubic Bicubic Don’'t downsample
s Resolution 72 dpi 150 dpi ]
© Compress using JPEG ZIP ZIP
Medium
% Downsample Bicubic Bicubic Don’t downsample
§ Resolution 72 dpi 150 dpi -
g Compress using JPEG ZIP ZIP
o Medium
5 o Downsample Subsampling | Subsampling | Don’t downsample
2 g Resolution 300 dpi 600 dpi -
£ = Compress using CCITT CCITT CCITT
£ Group 4 Group 4 Group 4
8 Compress text 1] [v] [v1]

59

Table 1 PDF Creator options
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5.1.3 Installing the Jaws printer driver

Jobs must be submitted to Jaws PDF Server in the correct PostScript language format,
otherwise the PDF cannot be created. The Jaws PostScript Printer Driver, supplied
with Jaws PDF Server, allows users to print jobs and submit them in the correct
format. To add the Jaws printer driver do the following:

1. Open the setup dialog box of a SmartInput module.

2. Click Create PS printer driver. The the New Printer Driver dialog box opens, as
shown in Figure 5.4.

Mew Printer Driver: [ %]

FPD File: IE:\Program Filez'Global Graphics') awsPDFServer\PPD \pdfcr EI

Drrivver Mame: IJ awsPrinter

()8 I Cancel |

Figure 5.4 Adding the Jaws printer driver

3. In the PPD File text box enter
C:\<path to installation folder>\PPD\pdfcreator.ppd
or click the navigation button | and select the driver in the dialog box that
opens.

4. Enter JawsPrinter in the Driver name text box to complete the details and
click OK to close the dialog box. Click OK once more to install the new printer
driver.

5. You can now configure the other options in the SmartInput settings dialog boxes
using the information from Table 2 on page 61.
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Options Smartinput Modules
Web Ready Printer Ready Press Ready

‘S Module name Smartlnput Smartlnput Smartlnput
g WebReady PrintReady PressReady
8 Destination modules WebReady PDF PrintReady PDF PressReady PDF

NT Share [v] 1] 1]

NT Share Name WebReady PrintReady PressReady
= HotFolder HotFolder HotFolder
_§ Mac Share 1 V] ]
g Mac Share Name WebReady PrintReady PressReady
< MacHotFolder MacHotFolder MacHotFolder
g PPD PDFCreator.ppd PDFCreator.ppd PDFCreator.ppd
£ Printer name WebPDF PrintPDF PressPDF
% Printer shared nhame WebPDF PrintPDF PressPDF
g PS Printer driver PDFCreator.ppd PDFCreator.ppd PDFCreator.ppd
>

Table 2 Smartinput options

5.1.4 Saving the workflow

After creating and configuring a workflow you will probably want to save it so that it
may be recalled at a later date. To save a workflow choose File > Save from the
menus. Enter a suitable name and location for the workflow then click Save. The
saved file cannot be used on other installations of Jaws PDF Server; for that you must
export the workflow then import it into the other installation. Click File > Export to
export the workflow, and File > Import to import an exported workflow.

5.1.5 Starting the workflow

The modules in a workflow must be started before jobs can be processed. To start the
workflow—and consequently its modules—choose Modules > Workflow Start from
the menus. When a module is running its status bar changes from black to clear, or
blue when the module is processing a job.

61
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5.1.6 Submitting jobs for processing

After setting up the example workflow you will have created three Jaws virtual print-
ers on your network; one for each type of PDF that can be created by the PDF server.
Users may submit jobs to the PDF server using the appropriate Jaws virtual printer
after first adding the printer—using the Add Printer Wizard in Windows or using the
Chooser on a Macintosh computer.

Note: Jaws virtual printers are not available for Mac users connecting to Windows XP.
The main manual offers an alternative solution for these particular users.

After generating the PDF the server outputs the file to
C:\JPS_Data\Output\PDF\<user directory>. Make sure your users have access
to this location on the server so they can collect their completed PDF files.

5.2 Example web and print PDF workflow

The second example workflow creates PDFs suitable for web use (low resolution,
small file size) and PDFs suitable for printing (medium resolution, medium file size).
Table 5.2 summarizes the main features for the two types of PDF files created by the
workflow.

Web ready Print ready

Feature PDF PDF
File resolution 72 600
Optimized for fast web Yes No
viewing?
Thumbnails included? No No
Color images 72 150
resolution
Grayscale images 72 150
resolution
Monochrome images 300 600
resolution
All fonts embedded? Yes Yes
Security implemented None None

Table 5.2 Summary of PDFs created by workflow

Jaws PDF Server 3.0 62



5 Example Workflows

63

5.2.1 Setting up the example workflow

The example workflow is supplied with Jaws PDF Server as a MaxWorkFlow export
file (.me£). The file contains all the information needed to recreate the workflow and
configure the modules correctly to produce PDFs suitable for web and print use.

In Jaws PDF Server, select File > Import and navigate to

C:\JPS_Data\pdf .mef and click Open. The new workflow is installed on the
Design palette, as shown in Figure 5.5, and each of the modules are automatically
configured with the correct options for creating print and web PDFs.

i
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Prirt

T
2

—
.
Gueuer

jia
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VWigh and Prirt Wik

V| V%]

Figure 5.5 Example web and print PDF workflow

5.2.2 Creating virtual printers

After importing the workflow, setup Jaws virtual printers for each of the SmartInput
modules. These will allow users to submit jobs to the workflow easily. Open the
SmartInput module setup dialog box and select the Virtual Printers tab. Depending on
the type of users you have, follow the instructions below, and repeat the same proce-
dure for all three SmartInput modules.
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Macintosh users

In the Mac Printer options, enter a name for the virtual printer in the Printer
name text box. In the PPD text box enter
C:\<installdir>\PPD\PDFCreator.ppd.

Windows users

In the NT Printer options, enter the name of the printer in the Printer name text
box. Choose a name for the printer share (this is the name of the printer as it will
appear on the network). You may use the same name for both printer and printer
share, but do not choose a name that is already in use on your system. From the
list of printer drivers choose PDFCreator.ppd. If this driver is not listed, install
it by clicking the Create PS Printer Driver button.

5.2.3 Starting the workflow and submitting jobs

To start the workflow select Modules > Workflow Start. The status bars above each of
the modules change from black to clear. This indicates that the modules have been
started and are ready to process jobs.

To submit jobs to the server, users will need to add the virtual printers that you created
for each SmartInput module. The virtual printers are added to the users machines
using the Windows’ Add Printer Wizard, or through the Chooser on a Macintosh
computer.
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SmartInput

'\\IJ.:

The SmartInput module is the gateway through which jobs enter the workflow. Users
submit jobs to the SmartInput module either: by printing the document on the

Jaws PDF Server printer (see Using a Jaws PDF Server virtual printer on page 50); or
through a hot folder published on the network (see Using a hot folder on page 51).
SmartInput constantly checks for incoming jobs in the Scan directory (see page 70)
and passes them to the next module or ignores them, depending on the file mask in
use.

6.1 Smartinput workflow

SmartInput processes PostScript language files (PS and EPS), PDF documents and
raster files. Jobs are placed in the scan directory where SmartInput picks them up and
passes them to the next module. You can configure the module to only process jobs of
a certain file type or file mask—see File type and File mask on page 70 for details on
how to do this. You can also configure SmartInput to deal with files submitted in error
that output devices are unable to process, for example application files. For details on
configuring error policy options see Error policy on page 71.
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The SmartInput module passes its output directly to a PDF Creator module or to a
Queuer module where the job is queued prior to being sent to a processor module,
Figure 6.1 shows these types of workflows.

$——8—T1
= (@
Smartinput PressReady Queuer JAWSE PDF Crestor PressReady
— | FOF | ]
s -

\ JAWSE PDF Crestar WebReady

Smartinput WebhResady \\ /
Queuer\
s

é

JBWE PDF Crestor PrintResd
Smartinput PrintResdy FESIOr rREay

Figure 6.1 Example Smartinput workflows
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6.2 Smartinput controls

On the Design palette right-click SmartInput module to access the module’s pop-up
menu, shown in Figure 6.2. From here all the module’s configuration and viewing
options can be easily accessed.

Setup F5
Inzert From ... Chil+F2
Wiew F4
Llear Error

Launch module
Change Computer... FE
Delete [rel

About Module Chrl+F1

Figure 6.2 Smartinput pop-up menu

The pop-up menu contains the following items:

Setup Opens the SmartInput setup dialog box, where configuration
options for the module can be specified. Section 6.3, starting
on page 68, describes each of the options in detail.

Insert from Allows you to sweep jobs from another folder into the Smart-
Input module. For more information see Section 6.4 on
page 76.

View Opens the module’s View window, where job processing and

log messages can be observed. Section 6.5 on page 77,
describes the View window in detail.

The other options in the pop-up menu are common to all modules and are
described in Section 3.8, starting on page 35.

6.3 Configuring the Smartinput module

The SmartInput module is configured through the SmartInput setup dialog box. To
access it, right-click the SmartInput module on the Design palette and choose Setup
from the pop-up menu; alternatively select the SmartInput module and click the
Object Setup tool in the Control toolbar.
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The options in the dialog box are organized into tabbed areas, which are described

next.
Setup F5
Inzert From ... Chil+F2
Wiew F4
Llear Error

Launch module
Change Computer... FE
Delete [rel

About Module Chrl+F1

6.3.1 General tab

Smartinput Setup

General l Additional ] Yirtual Printers ]

Module name: |Smart|nput PrezzReady

Scan directony: |EI:\JF'S_Data\lnput\Smartlnput_F'ressF!eady ?S'E:

Backup directorny: | E

Destination modules:

File masgk: |"_" ﬂ v Jaw'S PDF Creator PressReady [ps.e
File type: ’m
Buffer size: 2048 KB

Error policy

" Pauze Smartinput module on error
" Delete emor file and continue work

&+ Move emor file to eror directary

Cancel

Figure 6.3 General tab

Module name

Allows you to assign a reference name to the SmartInput module. The name
may contain up to 50 characters, with spaces. Initially, the module name is auto-
matically assigned by the system when the module is placed on the
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Design palette. You may continue to use this name or change it to something
more descriptive if you wish. The name is used wherever the module is refer-
enced, for example on the Design palette and in message logs.

Scan directory

The scan directory is the disk location into which jobs are placed as they enter
the workflow. The system automatically creates the scan directory as the Smart-
Input module is placed on the Design palette. You may choose a different loca-
tion by typing it directly into the text box, or by clicking the folder button &
adjacent to the text box and navigating to the new folder in the dialog box that
opens.

It should be noted that jobs placed in the scan directory are automatically
deleted once they have been processed. If you want to preserve jobs specify a
backup directory (see below) to place a copy of the file in the scan directory.

You can also sweep files from another folder into the workflow by right-click-
ing on the SmartInput module and choosing Insert from in the pop-up menu, see
Section 6.4 on page 76 for more information.

Backup directory

Allows you to specify the location of a backup directory to keep copies of jobs
which enter the scan directory. Enter the location directly into the text box or
click the folder button & and navigate to a folder in the dialog box that opens.

File mask

Allows you to specify a file mask to filter jobs that enter the scan directory.
Only those jobs that match the file mask are passed on for processing. Common
file masks can be selected from the menu, or you may enter your own by typing
directly into the text box. You may use any acceptable file name character,
including the wildcards (*) and (?7), where (*) represents zero or more characters
in a string of characters, and (?) represents any one character. For example:

* Matches all files.

*.ps Matches files with extension .ps.

Xyz.* Matches files called xyz with any extension.

XYzZ* ., * Matches files starting xyz, or example, xyz123.ps.
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22z% % Matches files with z as 3rd character, for example
xyzl23.ps.

File type

This option filters jobs according to file type, so that only files of the specified
type are passed on for processing. From the menu, choose which particular file
type to process, so that all other types are excluded. You may find this option
particularly useful when processing jobs submitted from Macintosh users,
which do not necessarily adhere to the Windows standard of describing file type
within the file’s extension name, for example .ps to specify a

PostScript language file.

Buffer size
Reserves an area of system memory for the spooling of files by SmartInput. The
recommended setting depends on the amount of memory (RAM) in your PC:
* 128 Mb RAM set buffer to 2048 kb
* 256 Mb RAM set buffer to 4096 kb

e 512 Mb RAM set buffer to 8192 kb
Error policy

Determines the action to take when a file is received into the SmartInput folder that

cannot be processed by the system, for example application files and bitmap images.
There are three options available:

Pause module on error

The module is stopped so that no further processing can
occur. You must manually delete the file, then restart the
module to enable processing to continue.

Delete error file and continue work
The error file is deleted so processing can continue.

Move error file to error directory

The erroneous file is moved to JPS_Data\Input\SmartIn-
put<x>\Error and processing continues.
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Destination modules window

So that jobs can be processed you must choose at least one output destination
device so that jobs can be directed appropriately. All connected output devices
are listed in the Destination modules window, select the check box (or check
boxes) that you want jobs to be directed to.

Note: By default no destination module is assigned to the SmartInput module.

6.3.2 Additional tab

Smartinput Setup [ %]

General  &dditional | Wirtual Printers I

v MT share

MT share name: ISmartInput PrezzReady

— I Mac Share
Mac Share name: I

Gueuer job priority: ID jl [ 0 - minimal priority, 10 - maximum |

File: stabilize time: |3 S,

()8 I Cancel

Figure 6.4 Additional tab

The Additional tab contains the following options:
NT Share

Selecting this check box publishes the scan directory as a public hot folder on
the Microsoft network, allowing Microsoft network users to submit jobs directly
to the workflow for processing.
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Since the public hot folder is simply an alias for the scan directory, it shares the
same features as it. That is, it accepts PostScript language files, PDF and TIFF
images, is able to filter jobs according to a chosen criteria and deals with files
that cannot be processed, according to the error policy in force.

NT Share name

Enter the name of the public hot folder for Microsoft users on the network. The
folder is published on the network with Guest read/write access rights.

Note: The Guest account in Windows 2000 is disabled by default. The network
administrator should therefore activate the Guest account so users can access
the hot folder. Alternatively, change the share rights to the hot folder according
to your own requirements.

If you have Window 95/98 users there is an important limitation to consider: the
share name needs to be 8 characters or less, with no spaces. This limitation does
not apply to Windows NT and 2000 users, where you can use up to 50 charac-
ters, with spaces.

Mac share

This option performs the same function as the NT Share check box, but in this
case the public hot folder is made available to Mac users.

Mac Share name

Enter the name of the public hot folder as it will appear to Mac users. On the
client machine the public hot folder can be accessed in the usual manner,
through the Chooser in Mac OS 9 and through system resources on Mac OS X.

Queuer Job priority

Allows you to enter a priority number to jobs entering the SmartInput input
directory. The Queuer uses the priority number to determine job processing
order where jobs with a high priority are processed before those with low
priority.

File stabilize time

73

Allows you to specify the waiting time for files entering the scan directory to
enable them to stabilize before they are submitted for processing. The default
delay is 3 seconds, which should be adequate for most files. If users are submit-
ting particularly large files the delay can be extended to allow more time for the
file to be completely written to disk.
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6.3.3 Virtual printers tab

The Virtual Printers tab allows you to create a virtual printer so that users can send
jobs directly to the workflow from an application such as Microsoft Word or QuarkX-
Press. The virtual printer generates the PostScript language file and places it in the
scan directory, where it is picked up by the SmartInput module and processed by the
workflow. See also, Section 4.2, “Submitting jobs for processing”.

Smartinput Setup [ %]

ﬁenerall Additional ~ Virtual Printers |

— Mac Printer

Frinter name: IPressHeadyPDF Create printer | [elete printer |

FFD: IE:\Program Filez'Global Graphics') awsPDFServeryPPDY fg'}; |

— NT Printer

Frinter Mame: IPressHead}lF’DF [Efeate prifter: | [VElEte printer |
Frinter Shared Mame: IPressHeadyPDF

PS Printer drivers: '/F [PDFCREATOR.PPD)] ;I
JPS_020204 [PDFCREATOR.PPD)
JawsPrinter [PDFCREATOR.PPD) J

Jaws PDF Creator [PDFCreator.ppd]

HP Laserlet ll15i PostS cript +52.3 (HP351523.PPD)
HP Laserlet 55i/55i Mx PS5 [HPLIBS.PPD)

HF Color Lazerlet PS [HP__CLI1.PPD)

HP Color LaserJet 5/50 PS [HPCLISVZ PPD)

-
A A~k DC 2 i nDm b mriet Db e (MECDD T O DOM _I

Lreate PS printer driver | Bemove PS printer driver |

()8 I Cancel |

Figure 6.5 Virtual Printers tab

Mac printer

Printer Name
Enter a name for the virtual printer. The virtual printer is published to Mac users
and appears in the Chooser in Mac OS 9 and as a network resource in

Mac OS X. Since Windows XP does not support AppleTalk it is not possible to
create a virtual printer for Mac clients connecting to Windows XP.

PPD

The name and location of the printer description file. Enter
C:\<installdir>\PPD\PDFCreator.ppd in the text box or click f&|and
navigate to the folder.
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NT printer

Selecting this check box publishes the virtual printer on a Microsoft network
and makes it available to your Microsoft users. Users add the printer in the usual
manner, that is, using the Windows Add Printer wizard.

Users who use Windows 95/98 are prompted for a printer driver after adding the
virtual printer. The printer driver is available in the Jaws PDF Server installation
folder, under Drivers. As the administrator, you need to make the driver avail-
able to the client. For Windows NT/2000 users the printer driver is automati-
cally installed after adding the virtual printer, the user is not prompted for a
printer driver.

Printer name

Enter a name for the virtual printer. To avoid potential system conflicts you
should not use a name that already exists for a printer or folder on the server.

Users can add the virtual printer to their computer using the Windows’

Add Printer Wizard. After adding, Windows 95/98 users will be prompted for a
printer driver. The printer driver is available in the Jaws PDF Server installation
folder, in the Drivers subfolder. As administrator, you must make sure the driver
is available to the client by placing it in a shared folder. In

Windows NT/2000/XP the printer driver is automatically installed when the
virtual printer is added to the user’s machine.

Printer shared name

Enter a name for the virtual printer as it will appear on the network to client
machines. You may use the same name as chosen for Printer name, above. If
you have Windows 95/98 users, the virtual printer name must not be more than
8 characters and spaces are not permitted. This limitation does not apply to Win-
dows NT /2000 users, where you may use up to 50 characters, with spaces.

PS Printer drivers
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This area lists the PostScript printer drivers (PPDs) currently installed on your
system. From the list choose PDFCreator.ppd to ensure that PostScript lan-
guage files created by the virtual printer can be processed correctly by the work-
flow modules. If you cannot see PDFCreator.ppd in the list, you should install
it by clicking the Create PS Printer Driver button, as described next.
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Create PS Printer Driver

This button allows you to install a new PostScript printer driver (PPD) on your
system. We recommend that you install the Jaws PDF Creator PostScript printer
driver and use this when setting up your virtual printers, as described above.

To install the Jaws PDF Creator PPD do the following:

1. Click the Create PS Printer Driver button to open the New Printer Driver
dialog box.

2. In the PPD File text box enter ¢:\<installdir>\PPD\PFCREATOR.PPD,
or use the folder button & to navigate to the PPD directory and choose
PDFCREATOR. PPD.

3. Enter a name for the new printer driver in the Driver name text box, limited
to 12 characters only.

4. Click OK to create the new printer and add it to the list of PS Printer drivers.
You may now select this printer when setting up your virtual printer.

Remove PS Printer driver

Allows you to remove a printer from the PostScript printer drivers list. Select
the printer from the list and click this button to remove it.

6.4 Insert from

This option is available in the SmartInput pop-up menu. It allows you to sweep jobs
that are PostScript language files and TIFF images jobs into the workflow for process-
ing. This feature can be used, for example, to resubmit jobs that have already been
processed (and stored in a backup folder), or submit jobs from another folder, as and
when the need arises.
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Choose Insert from to open the Select Directory window, shown in Figure 6.6.
Navigate to the folder where the jobs are located and click OK. It should be noted that
files are not deleted from the Insert from folder (as is the case when using a scan direc-
tory). Also, job files that are not of the correct type (PDF, PS, EPS or TIFF) are simply
ignored and are not sent for processing.

Select Directory E

Diirectory Mame:
|CAMWF_DatahBackup

Directories: Files: [=.7]

= T

Diives:

=l =1

Figure 6.6 Select the folder to insert from

6.5 Smartinput View window

The SmartInput View window, show in Figure 6.7, lists all the SmartInput modules
that are on the Design palette, showing their status, log, and pause states.

Open the View window by:
e double-clicking the module, or
» right-clicking the module and choosing View from the pop-up menu, or
* selecting the module and choosing the Modules > View menu item, or

* selecting the module and pressing F4 on your keyboard.
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—  Module “iew Help

Menus

Toolbar
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Mame Statuz Log | Pause

Idle yes  pes
Smartinput PrintFeady Idle yes  pes
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View list

—

Messages
area

Smartinput: Create NT printer Jaws PDF PressReady at 15801102 J
120321

Smartinput 9 Creste NT printer Jawes POF - Printyveb at 1501102
120327

|

Figure 6.7 Smartinput View window

The features of the SmartInput View window are described next.

6.5.1 Menus

6.5 Smartlnput View window

The menus are used to access commands and options in the View window. Click a
menu heading to open the menu and choose the appropriate option. For ease of access,
many of the menu items have been assigned a keyboard shortcut. Each menu option is

described next.

Module > Start /Stop
This menu option starts/stops the selected module in the View
list. Jobs can only be processed when a module is currently

running (started). Stopping the module ceases all processing
and stops jobs from being sent to the module, jobs are then
queued until the module is restarted.

You can also start/stop a module with the Start / Stop tool

(described in Section 6.5.2) or by pressing F2.
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Module > Abort job
Choose this menu item to immediately stop a module from
any further processing on the current job. The job is aban-
doned and processing continues with the next job.

Module > Setup
Choosing this option opens the SmartInput set up dialog box
where module options are configured. The options in this
dialog box control all configurable aspects associated with
setting up the module such as module name, directory loca-
tions and virtual printers. The SmartInput setup dialog box is
described in Section 6.3.

You can also access this command by pressing F5.

Module >Shut down
This menu option shuts down all SmartInput modules on the
Design palette. When a module has been shut down the
module appears disabled on the Design palette and its icon is
removed from the Windows’ System Tray. The module is
also removed from system memory. It may be necessary to
use this option if the system becomes unstable or if a system
access violation error occurs.

To re-launch the module, right-click it on the Design palette
and choose Launch Module from the pop-up menu.

View > Hide Window
This menu item closes the window when the toolbar is
anchored, or show/hides the View list when the toolbar is
detached.

View > Log Window
Hides the Messages area of the View window. The Messages
area is described in Section 6.5.4.

View >Toolbar
Use this menu item to show or hide the View window toolbar.
The tools in the toolbar are described below.
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6.5.2 Toolbar

The toolbar is usually anchored above the View list, but it may be pushed off and
become detached on the Windows Desktop.

=== Show / Hide
#  Use this tool to hide the View window when the toolbar is anchored in its
—) default location (below the menus), or use it to show/hide the View list when
the toolbar is detached.

Start /Stop
> Use this tool to start and stop modules. A module must be started in a work-
flow before it is allowed to process jobs. The button icon shows the action to
11 perform when the button is clicked, that is, when the button shows » click-
ing it starts the module.

Delete
H Use this tool to remove the selected module from the View list and also
remove it from the Design palette.

6.5.3 Module list area

The headings for the modules list area are as follows:

Name This column lists the name of the SmartInput module as it
appears in the Design palette. The module name is configured
in the SmartInput setup dialog box, described on page 69.

Status This column indicates the current processing status of the
module, that is, whether a module is currently idle or busy
processing a job.

Log This column indicates if the module is set to generate mes-
sages as it processes a job. When set, messages are output to
the Message log window and also to the log file MFW. LOG, see
page 30 for details on how to specify the location of this file.
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Pause This column indicates the current stop/start status of the
SmartInput module. To process a job, a module must be
started, and any jobs passed to a stopped module will be held
there until the module is restarted.

6.5.4 Messages area

Whenever the module performs some action, that is, when it is started or stopped,
when a job is processed or when an error occurs the module generates a descriptive
message and outputs it to the Messages area. Using the Log tool, described on page
18, you can also output these messages to a log file so they can be viewed later in a
text editor.
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The Queuer module performs several important functions in the workflow:

e It helps maintain the job flow by managing process queues and by monitoring
output device status, so that, for example, if a module is stopped or taken off-
line the Queuer will hold output for that device until it is restarted.

e Itis able to multiplex jobs so the workload is shared equally between output
modules in the workflow. This option is generally used where modules are con-
figured to run on multiple servers or when the server has multiple processors
installed.

* It may be employed to store processed jobs so they can be reprocessed or sent
to another output module. This saves the client from having to resubmit the job.

7.1 Queuer workflows

Figure 7.1 shows example workflows that use the Queuer module:

e In the bottom workflow the Queuer is used to multiplex jobs across several
servers to create the same type of PDF document.
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In the top workflow the Queuer is used to direct jobs to the appropriate
PDF Creator module as specified when the job was submitted.

£ T

—_—_— N WebReady PDF

Smartinput Print Gueuer PrirtResdy PDF
g
Smartinput Press PreszReady PDF

s

/Ready FDF

s . t @
M g
Smartinput Web Queuer WebReady PDF

Y

a
WebReady POF

Figure 7.1 Example Queuer workflows
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7.2 Queuer controls

On the Design palette right-click the Queuer module to access the module’s pop-up
menu, shown in Figure 7.2. From here all the module’s configuration and viewing
options can be easily accessed.

Setup F5
Wiew F4

Llear Error

Launch module

Change Computer... FE
Delete [el

About Module Chrl+F1

Figure 7.2 Queuer module pop-up

The pop-up menu contains the following items:

Setup Opens the Queuer setup dialog box, where configuration
options for the module are specified. Section 7.3, starting on
page 85, describes each of the options in detail.

View Opens the Queuer Viewer window where job processing and
log messages can be observed. Section 7.4 on page 88
describes the Viewer window in detail.

The other options in the pop-up menu are common to all modules and are
described in Section 3.8, starting on page 35.
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7.3 Configuring the Queuer module

The Queuer setup dialog box (Figure 7.3) contains all the options for the module,
which are described next.

Queuer setup
Module name: |Queuer

Storage Directory: |E:\JAWSPDFSEF|VEF|\St0rage H
™ Muliples Hold devices:

Jaw'S PDF Creator PressRead
[~ Spool job before processing festar FEssheacy

[V Last job on top

—

Delete policy

" Immediately after process

+ Keep |1440 it

" Mever [delete only marual)

" Delete oldest file if free disk space < [0 Mb

()8 | Cancel

Figure 7.3 Queuer Setup dialog box

Module name

Assigns a reference name to the Queuer module. The name may contain up to
50 characters, with spaces. Initially, the module name is automatically assigned
by the system as the module is placed on the Design palette. You may continue
to use this name, or change it to something more descriptive. The name is used
wherever the module is referenced, for example on the Design palette and in
message logs.

Storage directory
The storage directory is used to maintain a copy of jobs that enter the Queuer
module. Files are held in the storage directory until they are either deleted man-

ually or are deleted automatically by the system according to the Delete policy
settings, described on page 87.
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The default storage directory is set to C:\<installdir>\Storage but you
may enter your own location by typing it directly into the text box, or by click-
ing the folder button ]| and navigating to an appropriate location on your
system.

Multiplex

When this option is selected the Queuer module releases a job in turn to each
connected PDF Creator module; ensuring that all PDF Creator modules are used
equally to process jobs.

You may want to select this option if you have multiple connected PDF Creator
modules, each producing the same PDF type but running on separate servers, or
you have a multiprocessor computer. Figure 7.4 shows an example workflow
that employs three PDF Creator modules to produce the same type of PDF doc-
ument. Notice that two of the PDF Creator modules are running on remote
Jaws PDF Servers, indicated by the & icon in the workflow. By selecting the
Multiplex option you can ensure that all servers are fully employed in job
processing.

&

‘WehReady POF

L—8 I

Stnartinput Yiiek Queuer ‘WehReady POF

i

=
‘WehReady POF

Figure 7.4 Example multiplexed workflow

Spool job before processing

When this option is selected a file entering the Queuer is written to disk
(spooled) and allowed to stabilize before it is passed to the next module. This
ensures that all the file is written to disk before processing commences.
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This feature is usually desirable for very large files as it helps to manage the

load on the system and prevents processing errors. It should be noted though
that turning this option on will significantly increase processing time through
the workflow.

Last job on top

When this check box is selected jobs that enter the Queuer are placed at the top
of the queue and will be released before jobs already held by the Queuer.

Note: Jobs with high priorities will always be released from the Queuer before
jobs with low priorities, regardless of whether this option is turned on or off.

Delete policy

The delete policy options allow you to determine when jobs will be removed
from the Queuer once they have been processed. There are several options to
choose from, as described next:

Immediately after processing
Copies of jobs are not saved once they have passed through
the Queuer.

Keep nnn minutes
Jobs are saved for the specified period nnn minutes, after
which they are removed from the Queuer processed jobs list
and deleted from disk.

Never delete (only manual)
Jobs are saved until they are manually deleted from the
Queuer. To delete a job, select it in the Viewer and click the
Delete tool. The job is then removed from the list and deleted
from disk.

Delete oldest file if free disk space < nnn MB
Jobs are kept until the free disk space reaches a certain limit,
determined by nnn. After this, further space is created by
deleting the oldest files until the disk space surpasses the
limit.
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Hold devices

The Hold devices list shows all connected output devices. Selecting a check
box causes all jobs destined for that device to be held by the Queuer until they
are manually released by clicking the Release job tool, or are aborted with the
Abort jobs tool. See page 92 for details on releasing and aborting jobs from the
Queuer.

7.4 Queuer Viewer

The Queuer Viewer, shown in Figure 7.5, shows jobs that are currently held, pending
release when the destination module becomes available. The Viewer also lists those
jobs that have passed through the Queuer and which have been retained, possibly for
re-processing at a later date.

To open the Viewer, right-click the Queuer module and choose View from the pop-up
menu. Alternatively, press F4 on the keyboard. The Viewer is split into two main
areas: the upper area lists jobs that are currently waiting to be released from the
Queuer; the lower area lists jobs that have been processed, and which have been
retained for possible future processing. These jobs are stored on the hard disk in the
Storage folder, as specified in the Queuer setup dialog box, described on page 85.
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Module  Wiew Jobs Help
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Processing a job
Receiving a job
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Figure 7.5 Queuer Viewer

Each job in the Viewer is listed with the following information:

Job Id A unique identification number automatically assigned to the
job by the system.
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Processing / Passed Job
Name of the job, which is usually the name of the file submit-
ted to the workflow. The job name can be changed with the
Change names tool, described on page 93.

Page The job page number. This field only applies to jobs that have
been split into multiple pages.

Color The separation color of the job. This field only applies when
the job has been split into separations.

Date Date the job was submitted for processing.
Time Time the job was submitted for processing.
Type File type of the job. The system is able to process PostScript

language files (PS, EPS), PDF and TIFF files.
Size Memory size of the job in bytes.
Destination Destination output device for the job.

7.4.1 Viewer Toolbar

The Viewer toolbar, shown in Figure 7.6, contains tools for manipulating jobs listed
by the Queuer. Some of the buttons in the toolbar are applicable to only one of the lists
(processing jobs or passed jobs) and consequently appear dimmed when the tool is not
available for a particular job.

Jolr P =Y

Figure 7.6 Control toolbar
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The controls in the toolbar work on selected jobs as follows:

8

Show / Hide

Hides the Viewer when the toolbar is anchored, or is used to show/hide the
Viewer when the toolbar is free-floating.

Start / Stop

Starts / stops the Queuer module. As with all modules, the Queuer must be
started before it can process jobs. The button icon shows the action to perform
when the button is clicked. That is, when the button shows [® clicking it
starts the module; and when the button shows 1 clicking it stops the module.

Reprocess jobs

Reprocesses jobs that have already passed through the Queuer, but which
have been retained for future processing in the passed jobs list. The job is
directed to the device as specified when the job was originally submitted. If
you want to redirect the job to a different device, then you should use Redirect
selected jobs, as described next.

Jaws PDF Server 3.0



7.4 Queuer Viewer

Redirect selected jobs

Redirects jobs that have been retained by the Queuer for future processing
(listed in the passed jobs area of the Viewer), to a different output device than
that originally specified when the job was submitted.

From the Select destination devices dialog box, shown in Figure 7.7, select the
new output device and click OK. The jobs are moved into the processing jobs
queue, where they are subsequently released to the destination device.

it Select destination devices  [HEIE

LD e oK
[ PDF Server - Document -
Cancel |

Figure 7.7 Select destination device dialog box

@ Abort jobs

Aborts jobs and removes them from the list of jobs waiting to be processed.
The jobs are also deleted from the hard drive, so they must be resubmitted if
they are required again.

H Delete jobs

Removes jobs from the passed jobs list and deletes them from the storage
folder.

Hold jobs
]

Holds jobs in the Queuer. Jobs may be subsequently released by clicking the
Release jobs tool. A hand symbol appears next to any held job.
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Release jobs

Releases a “held” job in the Queuer. According to the delete policy in force
(see page 87), when a job is released it is either placed in the passed jobs list
or it is removed from the Queuer and is deleted from disk.

Change names

Changes the name of the job listed in the Queuer. Click the tool and enter the
new job name in the dialog box that appears.

Change job priority

Changes the priority of the selected job. In Jaws PDF Server, jobs are released
from the Queuer according to priority, so that a job with priority 10 is released
before a job with priority 0. Jobs are initially assigned a priority as they enter
the SmartInput module, as configured in the Additional tab, described on
page 72.
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7.4 Queuer Viewer

Locates jobs in the Queuer according to some specified search criteria. The
Search dialog box, shown in Figure 7.8, allows you to search on any aspect of
job detail— job id, page number, job size, format type, and so on. Any jobs
found matching the search criteria are highlighted in the Viewer.

7.4.2 Menus

Job status =
’75' Processing jobs \LI

€ Passedjobs FindNest |
sobin: [ Carcel |
Deci: [

Mame: |corsist v ||

Page |

Colo:  [cansist v ||

pate  [- =77

Twe [

Size: = =l Kb

Dest: IconsistLI I

Figure 7.8 Search dialog box

The menu items are used to access the various commands and options available in the
Queuer Viewer. For ease of use, many of the menu items have been assigned a key-
board shortcut. Each menu item is described next.

Module > Start /Stop

Jaws PDF Server 3.0

This command starts/stops the Queuer module. In

Jaws PDF Server, jobs can only be processed by a module
that is running; that is, when the module has been started.
Stopping a module ceases all processing and stops jobs from
being sent to the module. Jobs are queued until the module is
restarted.

This command can also be accessed using the Start/Stop tool,
as described in Section 7.4.1, or by pressing F2.
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Module > Setup
Choosing this option opens the Queuer setup dialog box
where module options are configured, such as module name,
held devices and multiplex options. The Queuer setup dialog
box is described in Section 7.3.

You can also access the setup command by pressing F5.

Module >Shut down
This menu option shuts down the Queuer module on the
Design palette. The module appears disabled on the Design
palette when it has been shut down, and its icon is removed
from the Windows’ System Tray. The module code is also
removed from system memory. It may be necessary to use the
shut down option if the system becomes unstable, or if a
system access violation error occurs.

To re-launch the module, right-click it on the Design palette
and choose Launch Module from the pop-up menu.

View > Hide Window
This menu item closes the window when the toolbar is
anchored, or shows/hides the process and processed jobs list
areas when the toolbar is detached.

View > Process Jobs, Passed Jobs, Log Window
Use these options to select which areas of the Viewer to make
visible or hidden. Figure 7.5, page 89, shows the areas that
are controlled from this menu.

View > Toolbar
This option shows/hides the toolbar. The toolbar and its tools
are described in Section 7.4.1 on page 90.

Jobs > Reprocess
This option can be used to resend a job from the Processed
Jjobs list back to the original destination PDF Creator module.
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Use the Redirect option, described next, to send the job to a
different PDF Creator module, which saves you from having
to resubmit the job again.

Jobs > Redirect Selected Jobs
Choose this option if you want to reprocess a job through a
different PDF Creator module. Choose the job from the
Processed jobs list before selecting this option.

Jobs > Abort Job Choose this option to remove a job from the processing jobs
list so that it is not processed.

Jobs > Delete  Choose this option to remove a job from the passed jobs list.
This option also removes the job from the storage directory
specified in the Queuer setup dialog box, as described in
Section 7.3 on page 85.

Jobs > Hold This option can be used to hold a job that is currently queued
and waiting to be processed. The job can be released by
selecting Jobs > Release, as described next. You may want
to hold a job so that other jobs may be processed first, for
instance, if you urgently need to process a particular job.

Jobs > Release Use this menu item to release a job that is currently being
held by the Queuer.

Jobs > Change Names
This menu item allows you to rename a job. The new name is
passed to the output module and used as the final output file
name. Select the job from the list before choosing Change
names. In the Enter new job name dialog box, enter the new
name for the job, and click OK to finish.

Jobs > Change Priority
Choose this menu item if you want to change the priority of a
selected job. In the Queuer, jobs are released according to
their priority and then by the order that they are received,
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which is by default set as first-in-first-out but may be
changed to last-in-first-out by setting the Last job on top
option, Queuer, as described on page 87.

Jobs > Save as  This option allows you to make a copy of the selected job
using a different name.

Jobs > Select all Selects all files in a job list. Click on at least one item in the
list to make the list active, then choose Select all.

Jobs > Search  Use the search tool to find specific jobs in the processing jobs
list or the passed jobs list. You can search on any aspect of the
job including name, job id, page number, date, color and size.

Jobs > Search Again
Repeats the last file search.
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PDF Creator

i«

The PDF Creator module converts PostScript® language files (PS and EPS),
PDF and TIFF images into Portable Document Format (PDF) files that are fully
compliant with PDF 1.3 and 1.4 specifications published by Adobe® Systems
Incorporated.

Jaws PDF Server 3.0 98



8 PDF Creator

8.1 PDF Creator workflow

The PDF Creator module consumes PostScript language files and TIFF images to pro-
duce optimized PDFs. Figure 8.1 shows two simple example workflows, where the
PDF Creator module is used.

g—g—7

Stnartingput Queuer JAWE PDF Creator - PressReady

el

JAWSE PDF Crestar - PrintReady

t—8

Smartinput 9 Queuer\
(s

JAWSE PDF Crestor - WebReady

Figure 8.1 Example PDF Creator workflows
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8.2 PDF Creator controls

To access the PDF Creator controls, right-click the PDF Creator module on the Design
palette to open a pop-up menu, as shown in Figure 8.2. From the menu all the mod-
ule’s configuration and viewing options can be accessed.

Setup F5
Fonts Chil+F2
Wiew F4
Llear Error

Launch module
Change Computer... FE
Delete [rel

About Module Chrl+F1

Figure 8.2 PDF Creator pop-up menu

The PDF Creator pop-up menu contains the following options:

Setup Opens the Queuer setup dialog box where configuration
options for the module can be specified. Section 8.3 describes
each available option.

Fonts Opens the Fonts dialog box where you can manage the fonts
used in PDF files created by PDF Creator. See Section 8.4,
“Fonts in PDF Creator” for more information on using and
managing fonts in PDF Creator.

View Opens the PDF Creator Viewer, where job processing and log
messages can be observed. See Section 8.5 on page 119 for
more information on the Viewer.

8.3 PDF Creator options

PDF Creator options are configured in the setup dialog boxes accessed through the
module’s pop-up menu, or by selecting the module and pressing F5 on the keyboard.
As with other modules, the various options are arranged into tabbed dialogs, described
in the following subsections.
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8.3.1 General settings

Setup for JAWS PDF Creator 2 [ %]
ampression I Font Embedding I Security I

Module Mame: IJAW’S FDF Creator 2

r— File Options
FDF File Format: IPDF w13 j
Thumbnail generation: INone j
Resolution: |2540— dpi
I~ ASCI format I~ Optimize for fast web viewing

I Auto-rotate Pages

— Output Options

Output Faolder: IE:\JPS_D ata\Outputh\POF

Backup Folder: I

I~ Execute on job completion: I

I Share output folder as: I

I~ Append User Directory ta Path
I~ Use Title as Output file Name
¥ Ovenarite an existing POF File

Advanced.. |

()8 I Cancel |

Figure 8.3 PDF module general settings

Module name

Allows you to specify a name for the PDF Creator module that will be used on

the Design palette and in message logs when referring to that particular module.
You may use up to 50 characters with spaces.

File options
PDF File Format

Selects the output format for the PDF files created by the module. The options
are:

PDF v1.3 Uses the PDF 1.3 specifications published by Adobe®.
Supports 40-bit security encryption.
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PDF vl1.4 Uses the PDF 1.4 specifications published by Adobe.
Supports 128-bit security encryption.

Thumbnail generation

When selected this option causes PDF Creator to generate and embed thumbnail
images of each page into the PDF. These thumbnails are used as a navigation aid
in Acrobat Reader. It should be noted that Acrobat Reader 5.0 also generates
thumbnails, although these are produced at the time the PDF is opened.
Although embedding thumbnails results in slightly larger file sizes, it enables a
faster redraw of the thumbnails in Acrobat Reader.

Resolution

Allows you to specify the resolution at which the job is rendered. This affects
jobs which contain resolution-dependent (and therefore device-dependent)
code. If your job contains pattern fills, the printer driver attempts to snap the
pattern frequency to a sub-multiple of the device resolution. Some drawing
packages also use the resolution (in conjunction with the halftone frequency) to
calculate the number of steps to use for graduated fills. All other page elements
should be unaffected by the resolution. If the PDF is intended for printing, you
should set the resolution to be the same as the resolution of the intended final
output device; otherwise, you should only change the resolution if you experi-
ence poor-quality output with pages containing patterns or graduated fills.

ASCII format

If this option is selected any binary data (including compressed text) in the PDF
file is converted to a printable ASCII representation. This makes it safe to trans-
mit your PDF pages over a medium that does not support binary transmission
(e-mail for example). It should be noted that using ASCII format increases the
size of your PDF file.

Auto-rotate Pages

When selected the module attempts to determine the orientation of the majority
of the text on the page and rotates the page until this text is orientated upright.
The PDF Creator module will always honor requests for landscape output, how-
ever, some Windows applications produce landscape output by rotating the
output onto a portrait page. When printed out this is not a problem as the page
can easily be rotated. However, when producing a PDF this leads to text running
up the screen.

Jaws PDF Server 3.0 102



8 PDF Creator

Optimize for fast web viewing

Before distributing PDF files via the web you should make sure they are created
using the Optimize for fast Web viewing option.

This option reduces file size, and prepares the document for page-at-a-time
downloading, sometimes called byte-serving. You will generally find that this
option significantly reduces the files size of the your PDF document.

When a document has been optimized for page-at-a-time downloading, the web
server sends each individual page of information requested by the user, rather
than the whole PDF document. When working with large documents, which can
take a long time to download, using the Optimize for fast Web viewing option is
particularly important.

Text and graphics are compressed to suit web serving, therefore with this option
selected, any compression settings you may have configured are overridden.

Output options
Output Folder

The Output folder is used to specify a directory for the finished PDF file. Enter
the location directly into the text box or use the navigation button to the right to
locate a folder.

Backup Folder

When a backup folder is specified a duplicate PDF of the processed file is cre-
ated. This is an efficient method for producing copies of the output PDF since it
occurs simultaneously as the file is processed.

The use of a backup folder is especially useful when there is a need to preserve
the output PDF prior to it being sent for further processing. For example, you
may have set up your workflows so that the output from one PDF Creator
module becomes the input for another module, thereby destroying the original
file. The backup folder preserves the original PDF file so that it may be used
later.

Execute on job completion

103

You can use this section of the dialog box to define extra actions after the
module has created each PDF file. To do this, you type text specifying a com-
mand and its options in a way similar to typing in a Windows command prompt
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window. The command can be a simple batch file or a complex application, pro-
vided that you can give the command all necessary options and information on
the command line (a command needing operator interaction is likely to cause
problems), and the application is available on the computer running

Jaws PDF Server. For example, you can use such post processing commands to
e-mail the generated PDF to the user who submitted the job.

Select the check box to enable post-processing and enter the post-processing
command in the adjacent text box. Optionally, you can supply substitution
codes (as specified in Table 8.1), as well as options understood by the applica-

tion.

The command string should normally include the file extension and the full path
name of the application file. However, you can type just the file name if the
command file has extension . EXE and is in one of the folders specified by the

PATH variable.
Table 8.1 lists the substitution codes that can be used by the PDF Creator mod-
ule.
Code Meaning
Yof The output PDF file name, not including the full path.
%0 The full output directory path.
YU User name of the client who submitted the job. Defaults to
Unknown if the user name is not known.
%d Date the job was submitted for processing.
Yon The job name of the PDF file. This is not necessarily the same as
the file name.
%S Computer (system) name from which the job has been printed.

Table 8.1 Post processing substitution codes

Share output folder as

This feature allows you to publish the Output folder on your network as a shared
resource. Select the check box and enter a name for the folder in the text box.
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Append User Directory to Path

For Windows users, selecting this option directs the processed PDF documents
into client subfolders within the designated PDF output folder, thus making it
easy to locate the finished PDFs.

Note: This option is only available to Windows users who submit jobs with a
virtual printer. This feature is not implemented for Mac users.

Use Title as Output file Name

When this check box is selected PDFs are created using the same name as the
submitted job name. When not selected a PDF is created with an arbitrary name,
assigned by PDF Creator.

Overwrite an existing PDF file

Select this check box if you wish to overwrite any PDF the exists in the output
folder that has the same name as the newly created PDF. Uncheck the box if you
want to stop PDF Creator overwriting existing PDFs.
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8.3.2 Advanced settings

Click Advanced in the General dialog box to access the Advanced options, as shown
in Figure 8.4. These options generally apply to prepress environments.

Advanced E
r— Color Options
Transfer functions: IAppIy j

I~ Convert CMYK to RGE

[~ Convert device independent colors to device dependent colors
I Preserve Halftones

I~ Preserve Overprint

I~ Preserve Under Color Removal and Black Generation information

— Document Structuring Conventions [DSC]

Usze Z%BoundingB ox for: INothing j

I~ Preserve OF| comments

— Default Page Size

“width: |3.5 inch = Height: |11 inch -

0K | i Cancel

Figure 8.4 PDF module advanced settings

Transfer functions

Provides options for preserving, applying or removing transfer functions from
the PostScript language file. The options are as follows:

Apply The document is displayed the same on-screen as when
printed.

Preserve Transfer functions are preserved in the PDF file.

Remove Transfer functions are removed in the PDF file.
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Convert CMYK to RGB

This option affects any color images that are present in the job. When enabled,
any four-color CMYK images in the job are converted to RGB images in the
PDF. This may result in a smaller PDF file that displays on-screen more quickly.
You should enable this if your documents are intended for on-screen viewing,
but disable it if the PDF is destined for printing.

Convert device independent colors to device dependent colors

Enabling this option can cause an apparent color shift in the images to which it
is applied. The conversion that PDF Creator uses is better suited to photo-
graphic images than to CM YK approximations of spot colors. You may find that
on-screen reproduction of some graduated fills and tinted images is better with
this option disabled than with it enabled.

With this option selected, PDF Creator converts colors specified in
device-independent CIE-based color spaces into device-dependent RGB. This
produces PDF files which display more quickly. Otherwise, these colors are
converted into a device-independent calibrated RGB color space. This produces
PDF files which render more slowly, but whose colors are more constant across
properly set up output devices.

Preserve Halftones

With this option selected, any halftone changes requested by the job are passed
through to the PDF file. You should select this option when producing PDF files
for print, and disable it when producing PDF files for on-screen viewing.

Preserve Overprint

When this option is selected, any overprint parameters relating to graphics in the
original PostScript language file are passed through to the PDF file.

Preserve Under Color Removal and Black Generation information
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Select this option if you want to preserve under-color removal and black-gener-
ation information from the PostScript language file. This is normally only used
in prepress environments.
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Document Structuring Conventions (DSC)
Use %%Bounding Box for

As well as the conventional page size request embedded in the PostScript lan-
guage file, many files also contain comments describing the actual extent of
marks on the page. The options are as follows:

Nothing Lets you ignore comments.
Page Size Use the bounding box for the PDF page size.
Crop box Use the bounding box for the optional page cropping box.

Acrobat Reader always displays pages as if they were the size
specified for the page cropping box. Some applications may
generate their own cropping box information using pdfmark,
which overrides any cropping box set in this way.

Preserve OPl comments

OPI (Open Prepress Interface) is used to reduce network traffic by substituting
high-resolution images with low-resolution screen images for the purpose of
screen display and page make-up—often called FPO (For Position Only). Select
the check box to apply the OPI comments stored within the PostScript language
file. OPI comments in the PostScript language input file are reproduced as OPI
dictionaries in the PDF output.

It is not necessary for the high-resolution image data to be available to

PDF Creator since it passes the file name through to the output. PDF Creator
produces only an OPI 1.3 dictionary, only an OPI 2 dictionary, or both, depend-
ing on whether the PostScript language file input uses one or both versions of
the OPI comments.

Default Page size

The width and height boxes let you to specify the default page size for the PDF
page. It should be noted that these values are only effective when the file does
not already contain page size information. In general, PostScript language files
and TIFF files do contain page size information, so the values entered here have
no effect on the printed page size for these file types. Choose the unit of
measurement from the drop-down list.
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8.3.3 Compression settings

The Compression tab provides options for the output format of images from the

PDF Creator module. This option handles images in three different categories: Color,
Grayscale, and Monochrome. Also provided are options to re-sample images in all
three categories using subsampling, average downsampling or bicubic resampling.

Setup for JAWS PDF Creator 16 E

General Compression | Faont Embeddingl Securityl

— Color Images
Downzample: IAverage 'l Fiezolution: I‘IED dpi
Compressiorn: IZIF' 'l

— Grapscale Images
Downzample: IAverage 'l Fiezolution: I‘IED dpi
Compressiorn: IZIF' 'l

— Monochrome Images

Downzample: ISubsampIe 'l Fiezolution: IBDD dpi
Compressiorn: IEEITT Group 4 'l

¥ Compress Text

()8 I Cancel |

Figure 8.5 PDF module compression settings
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Downsample

The downsampling options determine how images in the document are handled.
Using the options you can control downsampling for color, grayscale and mono-
chrome images, independently of each other. The downsample options are as
follows:

Subsampling
Removes and discards vital information from the image as it
recalculates the image resolution. This can sometimes affect
color integrity, smoothness of tones and type. Subsampling is
an effective method for making documents web ready.

Average downsampling
Takes an average number of dots-per-inch and re-samples the
image.

Bicubic
Reduces the resolution by performing bicubic interpolation to
generate new pixel values. This option can generate more
pleasing results, though the PDF file will be slower to gener-
ate. Bicubic is not available with monochrome images.

Compression

Compression squeezes the image into a smaller package. It calculates how to fit
twice as much information (sometimes more) into a smaller package. Unlike
subsampling, most compression algorithms do not discard valuable information
(JPEG being an exception). Therefore, compression is an effective way to
manage file sizes on disk for press quality documents.

You can control compression for color, grayscale and monochrome images,
independently of each other. The compression options are as follows:

ZIP The ZIP filter uses a lossless compression technique and nor-
mally produces good compression ratios.
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JPEG The JPEG filter uses a lossy algorithm (which irretrievably
discards data), but it produces excellent compression ratios
on photographic images. When JPEG compression is selected
you have the option to select one of the options from the
Quality menu.

ccITT Group4 The CCITT Group4 filter uses standard fax compression, and
is only applicable to bitmap images.

Resolution

If you have enabled downsampling this option lets you specify the target resolu-
tion of the reduced images embedded in the PDF file. Typical resolution settings
that you might employ are three types of PDF documents are: 72 dpi for screen
and web-friendly PDFs; 600 dpi for printable documents, for example on an
office laser printer; 2540 dpi for commercial quality, press-ready printing.

Compress text

Select this check box to compress text.
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8.3.4 Font Embedding settings

Setup for JAWS PDF [ %]

General I Compreszion

Security I

Always Embed Mever Embed
Courier Times-Bold
Courier-Baold Times-Boldltalic
Courier-BoldD blique Times-ltalic
Courier-Oblique Times-Roman
Add... Remove Add... Remove

I~ Embed all fonts [except baze 14 fonts] [~ Embed base 14 fants
I Subset fonts
I~ Use ariginal True Type fonts

()8 I Cancel

Figure 8.6 Fonts tab

The font embedding settings provide options for how fonts should be used in the PDF,
as follows:

Always Embed

Fonts listed in this box are always embedded in the output PDF file. Use the
Add and Remove buttons to manage this list. You should check the terms of
your font license agreement before embedding any fonts. Named fonts will be
embedded if they are referenced in the original PostScript language file and are
available to the application.

Never Embed

Fonts listed in this box are never embedded in the output PDF file. Use the Add
and Remove buttons to manage this list.
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Embed all fonts (except base 14 fonts)

With this option selected fonts used in the original document are embedded in
the PDF document. This means text in the document can be displayed correctly
(with no font substitution) on whichever machine views the document.

With this option selected all characteristics for the entire font family are
included in the PDF file. For example, your page may only call for “Helvetica -
Regular” but since it is part of a family—which also includes bold, italic, black,
condensed and compressed—the information for all font variations are embed-
ded in the PDF document, thereby increasing the overall file size. To limit the
increase in file size, you should consider selecting Subset all fonts.

Embed base 14 fonts

If this is selected, all base 14 fonts present in the document are embedded in the
output PDF file. Selecting this option implicitly adds the base 14 fonts to the
Always embed list.

Subset all fonts

With this option selected, only subsets of the original fonts are embedded in the
PDF file. This is the preferred setting, since it leads to smaller files. However,
since not all members of the font family are available in the PDF, selecting this
may inhibit you from cutting and pasting text, and prevent a reader from editing
text in the PDF. For example, if your page calls for “Helvetica - Regular”, the
bold, italic, black, condensed, and compressed variations of the font will not be
embedded in the PDF file and, consequently, it may not be possible to edit this
text on a users machine unless they already have the font installed.

Use original True Type fonts
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This option prevents the module from trying to substitute similar looking (but
not exactly the same) Type 1 fonts.
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8.3.5 Security settings

The options in the Security dialog box enable security features in your PDF docu-
ments. The options that are available for selection in the dialog depend upon the PDF
file format that you have selected in the General tab, either PDF 1.3 or PDF 1.4, as
described on page 101. The encryption ‘strength’ of the file is also shown in the
Security tab, as shown in Figure 8.7.

Setup for JAWS PDF Creator 1 [ %]
Generall Eompressionl Font Embedding  Security |

Security level
. —_—
n force Encryption Lewvel: 128-bit [FDF 1.4) m

— Pazswords

Open Document: I

Change Security: I

— Security Options
¥ Allow Copying of Text or Graphics
¥ Allow Content Access for the Yisually Impaired

Changes Allowed
¥ Document Assembly ¥ Fillin Farms and sighing
¥ General Editing ¥ Comment Autharing
Printing: | Disabled =l
()8 I Cancel

Figure 8.7 PDF module security settings

Encrypt PDF Files

Select this check box to encrypt the PDF according to the level specified in the
Security tab, and to implement the selected security features.
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Passwords
Open Document

This text box allows you to specify a password which must be entered before
the document can be opened. The user will be prompted for this password when
the document is opened.

Change Security

This text box allows you to specify a password that a user must enter before
security changes can be made to the PDF document. You may also use this
password to open the document.

Note: It is not possible to open a password protected document without entering
either the Open Document password or the Change Security password. Because
of this, you should always keep a secure record of these passwords.

Security Options

The security options allow you to impose certain restrictions on the PDF to limit how
the document can be used. For instance, you can prohibit readers from editing the doc-
ument, copying text or graphics, or printing the PDF. Select the check boxes for the
options that you want to impose, and clear the check box for any option that you want
a reader to have access to.

If you enter a Change Security password, the security options can be changed at a later
date in the PDF.
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8.4 Fonts in PDF Creator

PDF Creator maintains a list of fonts that it can embed and substitute in the PDF doc-
uments it creates. To access the fonts list, right-click a PDF Creator module and
choose Fonts from the pop up window, to open the Fonts dialog box, shown in
Figure 8.8. Using the controls in this window you may add and remove fonts, and
determine how fonts will be substituted in PDF documents that are generated.

Fonts %]
Font Mame | Font File | - Add Mew |
a Bookman-Demi Puurmala-Cremi
a Baookman-D emiltalic Puumala-D emiltalic — |

R R Femove
a Bookman-Light Puumala-Light
a Bookman-Lightltalic Puumala-Lightltalic
E Courier CIrps Substitution |
E Courier-Baold crb.ps
E Courier-BoldD blique crbo.ps
E Courier-Oblique Ciro.ps
(%] Helsinki his.ps
%] Helsinki-Bold hlsb. ps . £
oy e ot i
4 | | » |_I Fants
IAII forts hd l
()8 I Cancel |

Figure 8.8 Fonts list window

This dialog lets you manage both Type 1 fonts (also known as ATM fonts or PFB
format fonts) and TrueType fonts. The core fonts that are installed with PDF Creator
are listed in red and may not be removed. The core font set includes clones of the 35
standard PostScript language compatible printer fonts, as well as stub files which refer
to them. For example, Helvetica is one of the standard fonts, but the font file for Hel-
vetica is just a stub that substitutes the clone font Helsinki instead.

Use the pull-down menu in the lower left corner of the dialog to select the type of
fonts to be viewed. The All fonts option displays all the installed fonts.
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Add New

To add fonts to the list click Add New. The Add Fonts window opens

(Figure 8.9) from where you can browse to the font folder and choose which
fonts to install. After restarting the PDF Creator module, the fonts will be avail-
able in the master fonts list and can be used in your documents.

Add Fonts E

List of fonts:
| Font Mame | Font File - 0K |
CenturyGothic Gothic.
d
Cancel |

L M = Select Al
1 il
Folder:

A Crrive:

Figure 8.9 Add Fonts window

Remove

Use the Remove button to delete selected fonts from the master fonts list. Fonts
which have been removed cannot be embedded or substituted in the document.
To remove fonts from the list select the items first and then click Remove.

Substitution
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This option allows you to select which fonts will be substituted (swapped) in the
document. Generally, it is preferable to use the exact font that was used in the
design of the document. However, there are times when this is not possible; a
font may be corrupt; or the original font may not have been sent with the origi-
nal file. In such cases the only solution is to substitute with a font that is very
similar in design to the original specified font.

If substitution were not available, the PDF module would do one of two things:
error and refuse to produce the job or substitute a default font that is not even
close to the way it should look. Either result is unacceptable.
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One solution is to open up all the pages in the original application program and
search and replace every occurrence of the problem font. This is not ideal as it is
time consuming; you may not have the original application and if you miss one
or two occurrences where the font was used the processing time would be
wasted.

Having the PDF module offer to do the substitution for you “on the fly” is the
best solution because all occurrences are guaranteed to be substituted.

In the Fonts window click the Substitution button to open the
Create font substitution dialog box (Figure 8.10).

Create font substitution [ x]
Mame of the substitution: ()8 |
IEourier

Cancel |

Font to substitute:

I Garamond LI

Figure 8.10 Create font substitution dialog box

Name of substitution
Enter the name of the font to substitute (swap out) from the document.
Font to substitute

From the menu choose the font that you want to substitute with (swap in). The
fonts in the menu are compiled from the master fonts list.

Jaws PDF Server 3.0 118



8 PDF Creator

8.5 PDF Creator Viewer

The Viewer window, shown in Figure 8.11, lists the jobs that have been processed by
the PDF Creator module, as well as a list of messages generated by the module.

To access the Viewer, double-click the PDF Creator module or right-click it and
choose View from the pop-up menu.

Job processing
indicator

JAWS PDF Creator - PrintReady
Module  Yiew Help

ll P ﬁ Microzoft ‘Word - Reports - Spring.doc

(TITTTTITT0]
Jobs l

Job Device

/ Spring.doc S PDF Creator - PrintReady BAOTA02 ... E. 16

Microzoft \Word - Reports - Spring.doc— JAWS PDF Creator - PrintReady  16/01/021...  16/01/02 12:04:35

D Microzoft \Word - Marketing Campaign...  JAWS PDF Creator - PrintReady  16/01/021...  16/01/02 12:01:21

Jobs list [ Micrasoft wiord - widgett Sales.doc Jéiw'S PDF Creator - PrintReady  16/01/021...  16/01/02 11:34:49
D Microzoft \Word - Reports - Spring.doc— JAWS PDF Creator - PrintReady  16/01/021...  16/01/02 11:28:32

Start proceszing job Microzoft Word - Reports - Spring.doc at 12:01:43 d
End processing job Microsoft Word - Reports - Spring.doc at 12:04:35
T {5tart processing job Micrasoft Word - Reports - Spring.doc at 12:04:38
End processing job Microsoft Word - Reports - Spring.doc at 12:08:16
Message |Og Start processing job Microsoft Word - Reports - Spring.doc at 12:20:47 :‘

Figure 8.11 PDF Creator Viewer

119 Jaws PDF Server 3.0



8.5 PDF Creator Viewer

The features of the Viewer are described next.

8.5.1 Menus

The Menu items are used to access the various options in the Viewer.

Module > Start /Stop

This command starts/stops the PDF Creator module. In

Jaws PDF Server, jobs can only be processed by a module
that is running; that is, when the module has been started.
Stopping a module ceases all processing and stops jobs from
being sent to the module. Jobs are queued until the module is
restarted.

This command can also be accessed using the Start/Stop tool,
described in Section 8.5.2, or by pressing F2.

Module > Abort Job

Module > Setup

This command immediately stops a module from any further
processing on the current job. The job is abandoned and pro-
cessing continues with the next job.

Choosing this option opens the PDF Creator setup dialog box
where module options are configured, such as resolution, font
embedding and security, as well as output and backup folder
locations. The PDF Creator setup dialog box is described in
Section 8.3.

You can also access the setup command by pressing F5.

Module >Shut Down

Jaws PDF Server 3.0

This command shuts down the PDF Creator module on the
Design palette. When a module has been shut down the
module appears disabled on the Design palette and its icon is
remove from the Windows’ System Tray. The module code is
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also removed from system memory. It may be necessary to
shut down a module if the system becomes unstable, or if a
system access violation error occurs.

To re-launch the module, right-click it on the Design palette
and choose Launch Module from the pop-up menu.

View > Hide Window
This menu item closes the Viewer.

View > Toolbar
This command shows/hides the toolbar. The toolbar tools are

described next.

8.5.2 Toolbar

The PDF Creator Viewer toolbar contains tools for the most commonly used com-
mands in the Viewer. The toolbar is usually anchored at the top of the Viewer, but it
can be pushed off and become free-floating on the desktop. Push the toolbar at its
edges to detach it. To place it back in the Viewer, move the toolbar into the Viewer,
just under the menus, and release.

m  Hide
#  Use this tool to hide the Module View window when the toolbar is anchored,
or to show/hide the View list when the toolbar is detached.

4 !

Start / Stop

Use this tool to start and stop modules. A module must be started in a work-

flow before it is allowed to process jobs. The button icon shows the action to

" perform when the button is clicked, that is, when the button shows » click-
ing it starts the module.

v

Abort job

H Use this tool to abort the current job in progress. The tool only becomes active
when a large enough file is being processed, otherwise the tool remains
disabled.
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8.5.3 Jobs list

The jobs list area shows all the jobs that have been processed by the PDF Creator
modules currently loaded on the Design palette. Each job is presented with the
following information:

Job Job name.

Device PDF Creator module that processed the job.
Time In Time the PDF Creator module started the job.
Time Out Time the PDF Creator module completed the job.

8.5.4 Message log

The View log area of the View window displays messages generated by the module. A
message is generated whenever the module is started or stopped, when a job is pro-
cessed or when an error occurs. These messages allow you to observe job throughput
and to help resolve problems. Using the Log tool, described on page 18, you can also
output these messages to a log file so they can be viewed later in a text editor.
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Appendix A

Jaws PDF Server Setup Tool

Jaws PDF Server Setup can be used to perform general system maintenance and regis-
try updates without having to reinstall the Jaws PDF Server application. Under normal
operations you should never need to use the controls in this utility. However, if you
encounter problems starting Jaws PDF Server, need to reinstall its printer port, or you
want to change the default data path, then you may use the Jaws PDF Server Setup
utility to reset them.
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To start Jaws PDF Server Setup, open the Jaws PDF Server program group and select
Jaws PDF Server Setup. The options in the Jaws PDF Server Setup dialog box, shown
in Figure 0.1, are each described next.

JAWS PDF Server Setup
D ataPath :

[CIPS_Dats J

V¥ Remove COM security?

Inztall Sentinel driver
Install MwF Print Port
Beqistry update

Figure 0.1 Jaws PDF Server Setup dialog box

Data Path

The Data Path may be used to specify a different default location for the data
files created by Jaws PDF Server. These files consist of configuration files, scan
directories for each SmartInput module, output folders for the generated PDFs,
as well as the location for the message log file.

Remove COM Security?

Select this check box to disable COM security on the application server. By
default, COM security is implemented in Windows N'T/2000 but has the effect
of blocking two Jaws PDF Servers from communicating with each other, so pre-
venting them from sharing jobs. See Section 3.9, “Networking

Jaws PDF Servers” for more information on sharing jobs across multiple serv-
ers.

Note: Removing COM security does not compromise security on the server. Its
effects are limited only to the objects under the control of Jaws PDF Server.
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Install Sentinel driver

Click this button to reinstall the Sentinel dongle driver. You may need to do this
if you are experiencing problems if, when starting Jaws PDF Server, the pro-
gram reports the dongle security has been violated, even when the dongle is
attached and the correct license file is being used. It is a good idea to click the
Registry update button after reinstalling the Sentinel driver.

Install MWF Print Port

The MWEF print port is installed by Jaws PDF Server during the installation pro-
cess and is used by the Jaws virtual printer when creating PDF files. If, for some
reason, the port has been deleted click this button to reinstall it.

Registry update

Click this button to re-register the Jaws PDF Server components in the system
registry. Under normal operations you should never have to perform this opera-
tion, however, if the dongle persistently reports a security violation then you can
try clicking this button to see if it fixes the problem.

Close

Closes the Jaws PDF Server Setup utility.
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